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Database Management System

C Fastracl Revision )

» Database: A database Is an organised collection of

interrelated information of a specific type. In the database,
the Information is stored In a structured manner that
makes it quick and easy to fFind informatlon.

> Features of Database: Some fFeatures of database are as

Follows:

» |t creates and stores data in the form of tables.
Tables are easy to work with.

» |tcan handle a large number of records stored in the
tables.

» |t is best used for a long-term data storage and/or
data sharing.

» It allows multiple users to use the database,
simultaneously.

» |tis easier to understand and use.

» Advantages of Database:

» DBMS offers a variety of techniques to store and
retrieve data.

» |t reduces or eliminates data redundancy.

» Data sharing is the primary advantage of DBMS. It
serves as an efficient handler to balance the needs
of multiple applications using the same data.

» Searching and retrieving of data is very easy in
DBMS systems.

» It ensures uniform administration procedures for
data.

» Database Servers: Database servers are dedicated

computers that hold the actual databases and run only
the DBMS and related software. Typically databases
available on the database servers are accessed through
command line or graphic user interface tools referred to
as Frontends; database servers are referred to as Back-
ends. Such type of data access is referred to as a client-
server model.

DBMS: A Database Management System is an application
program that is used to create and maintain a database.
It enables users to store, modify and view Information
from the database as per the requirements. It provides
a systematic approach to create, retrieve, update and
manage Information In a database. DBMS also prevents
database From unauthorised access. It is quite easy and
simple to use DBMS.

Categories of DBMS: Database management systems are
categorised into different types, based on the database
model used. A database model defines the method of
collecting, storing, managing and controlling the data. The
various database management systems, based on these
data models, are as follows:

» Flat File Based DBMS: Flat File Based Database
Management Systems, also known as Flat models,
are the simplest database management systems.
These store information in Flat files having rows and
columns to store data. Flat Files cannot be linked to
each other.

» Hierarchical DBMS: Hierarchical Database
Management Systems function on the parent child
tree-like model. These store the data items along
with the description of the data items, such as a
book with information on chapters and verses.

> Network DBMS: Network Database Management
Systems use a data model similar to Hierarchical
Database Management Systems. The major
difference between the two Is that the tree
structure in the Network models can have a many
parent to many child relational model. The Netwark
model structure is based on records and sets.

> Object-oriented DBMS: In these database
management systems, the object and its data or
attributes are seen as one and accessed through
pointers. Object-oriented database models
comprise varied structures and are quite extensible.

> Relational DBMS: Relatlonal Database
Management Systems are the most widely used
database management systems, today. These are
relatively easy to use. These store the information
in the Fform of tables. Relational Database
Management Systems are named so because of
the capability to link multiple data structures, /e,
tables. MS Access, Oracle, MS SQLServer, IBM DB2,
OpenQffice and MySQL are some of the commonly
used Relational Database Management Systems.

» Manipulating Data: Data manipulation means to perform

difFferent operations such as to view the records, to edit
and update the records and to delete the records stored
in a database when needed. Four different computer
languages are there, using the commands of which we
can manipulate the data stored in databases. These are as
Follows:
> Data Definition Language (DDL): The Data
Definition Language (DDL) Is used to create and
modify the structure of database objects. This
language basically contains commands that define
the structure of a database object such as a
table. This DDL Is also known as Data Description
Language.
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» Some commonly used commands of DDL are as follows:

» CREATE command: This command defines the
structure of a table. It describes the kind of data
to be stored in a table by declaring the number of
Felds, field names, field's length and the data type
of fields of a table.

» ALTER command: This command modifies the
structure of an existing database table. For
example, in case we want to add more fields or
change the data type of an existing field, we will use
this command.

» DROP command: This command deletes a table, or
other database obects such as index or view. For
example, if we want to delete a table, we will use
this command.

» TRUNCATE command: This command removes all
the table records including allocated table spaces.

» RENAME command: Thils command Is used to

rename an object in the existing database or table.

Manipulation Language (DML): The Data

Manipulation Language (DML) is used to manipulate the

data or records stored in the databases. For example, we

can view, delete, and update the records saved in table
using different DML commands. Some commonly used
commands of DML are as fFollows:

» SELECT command: This command is used to view or
retrieve the data from the database.

» INSERT command: This command Is used to insert
the data in a database. We can insert more records
in a table using this command.

» UPDATE command: This command is used to edit
and update the records in a database.

» DELETE command: This command Is used to delete
the data stored in a database.

Data Control Language (DCL): The Data ControlLanguage

(DCL) is used to control the access and permission given to

the users of a database. The examples of DCL commands

are GRANT and REVOKE.

» GRANT command: This command is used to provide
access privileges to database.

» REVOKE command: This command is used to
withdraw user’s access privileges to database.

» Transaction Control Language (TCL): The Transaction

Control Language (TCL) Is used to control the transactions
within the database.

» COMMIT command: This command is used to
committing a transaction to database.

» ROLLBACK command: This command is used to
restore the transaction in the case of any error.

» SAVEPOINT command: This command is used for
setting a save point within a transaction.

» SET TRANSACTION command: This command Is
used for specifying characteristics such as the read-
write/read-only access, etc., For a transaction.

Keys in DBMS: Keys play animportant role in the relational
database. It is used to uniquely identify any record or row
of data from the table. It Is also used to establish and
identify relationships between tables. KEYS in DBMS Is an
attribute or set of attributes which helps you to identify a
row (tuple) in a relation (table).
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» Why We Need a Key: Here are some reasons for using SQL

key in the DBMS system.

> Keys help you to identify any row of data in a table.
In a real-world application, a table could contain
thousands of records. Moreover, the records could
be duplicated. Keys in RDBMS ensure that you
can uniquely identify a table record despite these
challenges.

> Allows you to establish a relationship between and
identify the relation between tables.

» Help you to enforce identity and integrity in the
relationship.

» Types of Keysin DBMS (Database Management System):

> Super Key: A super key is a group of single or
multiple keys which identifies rows in a table.

> Primary Key: It is a column or group of columns in a
table that uniquely identify every row in that table.

» Candidate Key: It is a set of attributes that uniquely
identify tuples In a table. Candidate Key Is a super
key with no repeated attributes.

» Alternate Key: It is a column or group of columns
in a table that uniquely Identify every row in that
table.

» ForeignKey:Itisacolumnthatcreatesarelationship
between two tables. The purpose of Foreign keys
Is to maintaln data integrity and allow navigation
between two different instances of an entity.

» Compound Key: It has two or more attributes that
allow you to uniquely recognise a specific record. It
is possible that each column may not be unique by
itselF within the database.

» Composite Key: It is a combination of two or more
columns that uniquely Identify rows in a table. The
combination of columns guarantees uniqueness,
though individual uniqueness is not guaranteed.

> Surrogate Key: An artificial key which alms to
uniquely identify each record is called a surrogate
key. These kind of key are unique because they are
created when you don't have any natural primary
key.

» Properties of Primary Key Field: The properties of a

Primary Key Field, are as follows:
» Since, it uniquely Identifies a row/record, It does not
accept duplicate values.
» A Primary Key field cannot be left blank. So, it does
not accept Null values.

» Relatlonship between Tables: A relationship works by

matching data in key columns, usually columns (or fields)
that have the same name in both the tables.

» Types of Relationship: There are three types of

relatlonshlips. They are as Follows:

> One-to-Many Relationships: A one-to-many
relationship isthe mostcommonkind of relationship.
In this kind of relationship, a row in table A can have
many matching rows in table B. However, a row in
table B can have only one matching row in table A.

> Many-to-Many Relatlonships: In a many-to-
many relationship, a row in table A can have many
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matching rows in table B, and vice-versa. We create
such a relationship by defining a third table that
is called a junction table. The primary key of the
junction table consists of the foreign keys from both
table A and table B.

» One-to-One Relationships: In a
relatlonshilp, a row in table A cannot have more

one-to-one

than one matching row in table B, and vice-versa.
A one-to-one relationship is created if both of the
related columns are primary keys or have unique
constralnts.

» RDBMS: Arelational database Is a collective set of multiple
data sets organised by tables, records and columns.
Relational database establish a v/ell-defined relationship
between database tables. Tables communicate and
share Information, which Facilitates data searchabllity,
organisation and reporting. A Relational database use
Structured Query Language (SQL), which is a standard user
application that provides an easy programming interface
For database interaction

» Database Object:

» Tables: A table is a set of data elements (values)
that is organised using a model of vertical columns
(which are Identifled by their name) and horizontal
rows. A table has a defined number of columns, but
can have any number of rows. Each row is identified
by the values appearing in a particular column
Identified as a unique key index or the key field.

» Columns or Flelds or Attributes: A column s a
set of data values of a particular simple type, one
for each row of the table. The columns provide
the structure according to which the rows are
composed. For example, FirstName, or LastName
are flelds In a row.

» Rows or Records or Tuples: A row also called a
Record or Tuple represents a single, data item in
a table. In simple terms, a database table can be
visualised as conslsting of rows and columns or
Flelds. Each row In a table represents a set of related
data, and every row in the table has the same

structure.
» Creating Database Using OpenOfFffice:
» Open the OpenOffice Base Application by

Clicking on Start > Programs > OpenOfFffice.org
4> OpenOFffice.org Base.

» Create a new database by selecting the option
Create a new database.

» Database wizard appear. Click Finish. The Save As
dialog box appears.

» Specify a name for the database In the File name:
fField and click Save.
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» Create Tables: Tables are the basic building blocks of a
database. You store the data in the database In the form
of tables. There are different ways to create a table:

» Use Wizard to Create Table: The following are the
steps to create a table:

* Click on Tables > Use Wizard to Create Table.

» C(Click the Select Fields > Choose Category >
Select the table > Click on Next Button.

= Select the fields as per the requirements. Click
on Next button.

» Setthe data types and properties of the selected
Fields. Click on Next Button.

» Set the Primary Key and Click on Next Button.

* Window to rename the table will open. A user
can either go ahead with the same table name or
can change it.

» Click on Finish to insert the data in the table.

» Creating Table Using Design View

» Click on Create Table in Deslgn View.

» Specify the field name and data type of the fleld.

» Save the table by clicking on File > Save.

= Specify the table name. The default name Is
Table1. Click OK.

* Analert appears, if there s no primary key in the

table.
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» Data Types: Data types are used to identify which type of
data (value) we are going to store in the database. Fields
themselves can be of different types depending on the
data they contain. Data types in OpenOffice base are
broadly classified into five categories listed below:

» Numeric Types: Numeric data types are used for
describing numeric values for the field used in
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the table of a database. Numeric data types in a » Binary Types: Binary data types are used for
database can be used for storing information such storing data in binary formats. Binary data types in
as mobile number, roll number, door number, year a database can be using for storing photos, music
of school admission, true or false statements Hiies: ele. In-genekel, Fliag O30y Folmes @D be
o ' . - stored using the binary data type. The different
statistical values, etc. The different types of numeric types of binary data types available are listed here.
data types available are listed here.
Name Data Type Description
Name Data Type Description LONGVARBINARY |Image Stores any array
BOOLEAN |Yes / No Values as O or 1. of bytes (images.
Example: True or sounds, etc.). No
False. Yes or No validation required.
TINYINT  [Tiny Integer  [Store integer range BINARY Binary (fix) [Stores any array of
between O to 225 bytes. No validation
SMALLUINT |Small Integer [Store integer range required.
between -2° to +25-1 VARBINARY Binary Stores any array of
INTEGER |Integer Store Integer range bytes. No validation
between -27' to +27] required.
. » Date Time: Date time data types are used for
BIGINT Big Integer Range between -2% to
g Integ +2HB_1 describing date and time values for the field used
in the table of a database. Date time data types in a
NUMERIC [Number Maximum precision of database can be used for storing information such
e(+~31l as date of birth, date of admission, date of product
sale, etc. The different types of date time data types
DECIMAL |Decimal ::l:ai;num precision of “vallableareiitied hare
REAL - 2108 g (2-252)° 200 Name Description Format
= - wow Date Stores maonth. 1/1/99 to
FLOAT Float 2 fo (2"2 ) 2 dav and year 111!9999
DOUBLE |Double 2100 b (2-2-52)° D023 information
Time Stores hour Seconds since
» Alph i - *
planimenc Jypes minute and secand |[1/1/1970
Name Data Type Description information
LONGVARCHAR [Memo Stores up to the max Timestamp |Stores data and
length or number time informatian
indicated by user. It » Table Data View Dialog Box: Start typing the records
accepts any UTF 8 in the table with the data provided in the excel sheet
Character. and select File > Save Current Record to save data in the
CHAR Text (fix) |Stores exactly the table.
Lengl-h Epeci-ﬁed wt Aoroumis o WMan Deolunn? - OpardWico Do Toule Qo Ware x
h\,‘ user. padS with Eoo Bl Yow lowd Book Wewiow Help iy
trailing spaces for - B0 @- 5 IR P _
D LecoustD fropouid i AprouniMemday | Acooun] Typse | SuoouelTypall
shorter strings. A R ) 125458100 ARG |
Accepts any UTF B
Character. oo e 1
VARCHAR Text Stores up to the » Perform Operations on Table: In OpenOffice Base, data
specified length. No is stored in tables which can be inserted, modified and
padding (Same as removed using appropriate options.
longvarchar) > Inserting Data in The Table: To insert the data in the
VARCHAR_  |Text Stores up the table, follow the steps:
IGNORE CASE specified length. » Select the table > Double click an It.
Comparisons are nat » The table will open in Datasheet View.
s s s » Insert the required number of records in Datasheet
stores capitals as : View. z : ;
ot buse therm » Editing Records in The Table: To edit the data in the
el : table, follow the steps:
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» Select the table > Double click on it.

» The table will open in Datasheet View.

» Edit the required record in Datasheet View.
Deleting Records From The Table: To remove the data
from the table, follow the steps:

> Select the table > Double click on it.

» The table will open in Datasheet View.

» Select the data > right click on selected data > select

the Delete option.
Fleld Properties: To set the Field properties: Select the
table > Right click > Select the option Edit > the table
will open in design view. In design view there are different
properties of fAlelds according to the data type set for each
Field. The properties of numeric type data are given below:

» AutoValue: if set to yes then Field will get the auto

numeric values.

» AutoValue: if set to yes then field will get the auto

numeric values.

> Length: By default length of the Fleld Is 10 but the

size of the field can be set to maximum length.

> Default Value: A default value can be set for a fleld

if user don't provide any value while entering the
values in the table.

» Format: This property helps to set the fFormat of the

data entered in the field such as 91-222-333.
Properties of Character Type Data
The properties of character type data are glven below:

> Entry required: if set to yes then it will be must to

insert the value in the field.

» Length: By default length of the Fleld Is 10 but the

size of the field can be set to maximum length.

> Default Value: A default value can be set for a field

if user don't provide any value while entering the
values in the table.

» Format: This property helps to set the Format of the
data entered in the field such as 91-222-333.
Sorting Data: Sorting means to arrange the data in either

ascending order or descending order.

Referential Integrity: Referentlal Integrity is used to
maintain accuracy and consistency of datainarelationship.
In Base, data can be linked between two or more tables
with the help of primary key and forelgn key.

RefFerential Integrity Helps to Avoid:

» Adding records to a related table if there is no
associated record avallable in the primary key table.

» Changing values In a primary if any dependent
records are present in associated table(s).

» Deleting records from a primary key table if there
are any matching related records available in
associated table(s).

Creating and Editing Relationships between Tables:
A relationship refers to an association or connection
between two or mare tables. Relationships between
tables helps to:

» Save time as there is no need to enter the same data
in separate tables.

» Reduce data-entry errors.

» Summarize data from related tables.

» You can create a relationship between any two tables by
selecting Relationships option from the Tools menu. There
are three types of relationships which can be created in
tables:

» ONE-to-ONE Relationship: In this relationship,
both the tables must have primary key columns.

» One-to-Many Relationship: In this relationship,
one of the table must have primary key column.

» Many-to-Many Relationship: In this relationship,
no table has the primary key column.

» Remove the Relationships: The relationships applled on
the tables can be removed also with the help of Delete
optlon. Right Click on the relatlonshilp thread and select
Delete option.

> Retrieve Data Using Query:

» SELECT Statement: A SELECT statement retrieves
zero or more rows from one or more tables. SELECT
s the most commonly used Data Manipulation
Language (DML) command. To retrieve all the
columns In a table the syntax Is: SELECT * FROM
<Table Name>;
For example, if you want to display all the data from
table emp (short Form of employee), the command
is Select ®* from emp;

» The SELECT statement has many optional clauses:
« WHERE specifies which rows to retrieve.
» ORDER BY specifies an order in which to return
the rows.
» For example: Select * from emp where name = “Ravl”;

» The above query will show result of a particular employee
named “Ravi".

Select ®* from emp order by Salary;

» The above query will show all the records of table emp
according to ascending order of column Salary.

» Performing calculations: In Base, simple calculations can
be done on the data using arithmetic operators. Example:

» To display the salary of all the employees after
incrementing by 1000 then the following SQL
command will be executed in Base. (Fields of table
Employee are EmployeelD, FirstName, Salary)
Select “EmployeelD”, “FirstName”, “Salary”
+1000 From “Employee”;

» To display the salary of all the employees after
decreasing by 10000 then the SQL command will be:
Select "EmployeelD”, “FirstName"”, “Salary”-
10000 From “Employee”;

» To display the salary of all the employees after
incrementing it as twice the amount of present
salary, then the SQL command will be .

Select “EmployeelD”, “FirstName"”, “Salary” ¢ 2
From "Employee”

» Update Statement: Update statement is used for
modIfying records In a database. The general syntax of the
update statement is as Follows:

UPDATE <table name> SET <Column name > =
value [WHERE <Condition>];
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» For example: To increase(update) the salary of employee
“Ravi” by Rs 2000 (in table Employee)then the SQL
command will be:

Update Employee set Salary = Salary + 2000

Where FirstName = "Ravi";

» Form:A form provides the user a systematic way of storing
Information Into the database. It is an interface in a user
specified layout that lets users to view, enter, and change
data directly in database objects such as tables.

» Creating Form Using Wizard: Steps to create Form using
wizard are:

» Click Use Wizard to Create Form... option under
Tasks group. The Form Wizard dialog box appears.

» Select selective fields to be sent onto the form by
selecting the field name and clicking >button and
click Next.

» Select the option Add Subform IF you need to insert
the contents in the table in a separate form and click
Next.

» Arrange selected fields in a form and click Next.

» Select the data entry mode and click Next.
» Specify the styles to be used in the Form and click
Next.
» Specify the name of the form. Click Finish.
» Report: Areport helps to display the data in a summarised
manner. It Is used to generate the overall work outcome in
a clear Format.

> Creating Reports Using Wizard: Steps to create report
using wizard are:

» Click on Use Wizard to Create Report...
available under Tasks.

» Select all the table fields by selecting the >> button.

» Redefine the label of the fields in the reports or else
you can set the default name and click Next.

» Define grouping for the fields of the table if required
and click Next.

» Sort the field in the report by selecting the
appropriate field name and sorting method (if
required) and click Next.

» Select the layout of the report and click Next.

» Define a name far the report and click Finish.

option

& Practice Exercise

@é} Multiple choice Questions §)

Q1. Which one of the following is not an example of

DBMS? [CBSE 2023]
a. PostgresSQL b. SQLite
c. FoxPro d. Impress

Q 2. Which of the following software is appropriate to
store data about school students?

a. MS-Access b. Writer
c. Calc d. Impress

Q 3. Which of the following is not a database programs?
a. MysQL b. Oracle
c. Writer d. OObase

Q4. .............. .. store data in Single table.
a. FLat Flle b. Relational
. Single File d. One File

§ 1L A R— . are dedicated computers that hold
rJ1e actual databases and run only DBMS and related
Software.
a. Main Server b. Web Server

c. Database Server d. Non Database Server
Q6. GUI act as front end and database server act as

a. Container b. Back End

c. End d. None of these
Q7. Duplication of data is called ...........uueeuunnnne

a. Inconslstency

b. Conslstency

c. Redundancy

d. Fareign Key
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Q 8. Which of the following is not the advantage of
database?
a. Sharing of Data
b. Reduce Data Redundancy
C Increase Data Inconslistency
d. Data Security

Q 9. Which of the following will help to maintain unique
record in the table?

a. Forelgn Key b. Primary Key

c Camposite Key d. Alternate Key
Q 10. Which of the following field of table "Book” can act
as Primary Key?

a. Book_number b. Sublect

C price d. Author_name
Q1L When PrimaryKey is made up of two or more columns
then it is called.......................... Primary Key.
a. Mixed b. Reference
c Composite d. Compost

Q 12. Akeywhich is referring to the primary key of another

table is called..........aucaunneee
a. alternate Key b. Primary Key
¢ first Primary Key d. Farelgn Key

Q13. A field which is ......cceeiennnennnns
record is called Primary Key.

... for each and every

a. Cammon

b. Same

c Unique

d. None of the above
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Q 14.

Q 15.

Q 16.

Q17

Q 18.

Q 19.

Q 20.

Q2l1.

Q22.

Q23.
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When data is stored, maintained and retrieved from
multiple tables then special database software are
required called ...........ccuueen..

a. DBMS b. RDBMS

c. Special DBMS d. All of these
Identify the Foreign Key from table “Sales”
Table Client:

ClientID (Primary Key)

clientname

clientphone

Table Sales:

SalesID (Primary Key)

ClientlD

Profit

a. SalesID b. Profit

c. Clientphone d. ClientlD

Which of the following is not valid field of table

“Student"?
a. admno b. name
c. fees d. salary

In RDBMS, data is organised in the form of

a. Table b. Record

c. Fleld d. None of these

Which of the following is expanded form of SQL?
[CBSE 2023]

da. Systematic Query Language

b. Structured Query Language

c. Software Query Language

d. Structural Query Language
All the values in........................... are of same type.

a. Records b. Table

c. Database d. Fields

.......................... represent a single data item in a
table.

a. Tuples b. Attributes

c. Relation d. All of these

Database servers are referred to as.......ccceeveennee...
[CBSESQP 2021, Term-1]

b. back-ends

c. cllents d. model

A table is a set of data elements that is organised

using a model of vertical .............. and horizontal
[CBSESQP 2021, Term-1]

b. columns, rows

d. forms, reports

a. front-ends

FFFFFFFFFFFFFFFFFF

a. rows, tables

C. rows, columns

Which one of the following is an example of RDBMS?
[CBSESQP 2021, Term-1]

a. MongoDB

b. Windows reglstry

c. Publisher

d. Oracle

Q 24.

Q25. .

Q 26.

Q7.

Q 28.

Q 29.

Q 30.

Q3L

Q 32.

Q 33.

Q 34.

Q 35.

Q 36.

has evolved since the 1960s to ease
increasing difficulties in designing, building
and maintaining complex information systems.
[CBSESQP 2021, Term-1]

a. Knowledge concept
b. Formula concept

c Database caoncept
d. Forms concept

ceeersensenneennnnnnennee. dF€ the basic building blocks of a
database.

a. Tables b. Record
c. Fields d. Al of these

We can create table :

a. in design view b. use Wizard

c Both a. and b. d. Nane of these
By default data type of fields is:

a. Text[Varchar) b. Text(Char)

C. Int d. Long

By default the length of Varchar data type Is..............
a. 20 b. 30 c. 40 d. 50

By default the name of the table is......ccccviiiinicecnce.
a.Tab1 b. Table 1

C First Table d. Untitled 1
.......................... are used to identify which type of
data we are going to store in the database.

a. Datatype b. Record

c. Table d. Attributes

Which data type will be appropriate to store
information such as Salary, Fees, Price, etc.?

a. Alphanumeric Data types
b. Numeric Data type
c. Binary Data types

d. Date Time

Which of the following is not a numeric data type?
a. Tinyint b. Smallint

c. Boolean d. Date

Which of the following data types cannot store
decimal values?

a. Decimal b. Real

c. Numeric d. Boolean

Which of the following will occupy more space in
computer memory?

a. Bigint b. Integer

c. Smallint d. Boolean

Binary data types in a database can be using for
StOring .....evvvevnennnnas [CBSE 2023]

a. photos. music files. etc
b. integer values

c only Image files

d. only videa files

Char is 2 ...ccccccviiiveneeeee. length data type and
WArENat 153 ciaiinsasnisiaksoms length data type.

a. fixed, variable b. variable, fixed
c. variable, variable d. fixed, fixed
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Q37

Q 38.

Q 39.

Q 40.

Q 4l

Q42.

Q43.

Q44.

Q 45.

Q 46.
Q 47.
Q48.

Q 49.

Q50.
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Which field is suitable for storing records of
employees?

a. EmpNo b. Empname

. Salary d. All of these

Auto value is a property of..........cccceeee....... data type.
a. Numeric b. Character

C. Binary d. Date

Which of the following property help to set the
number of characters in Varchar type?

a. Auto Value b. Required

c. Default Value d. Length

Which property ensures that field cannot be left
blank?

a. Entry required b. Format

C. Required Entry d. Required

By default the length of the Integer data type is

a. 10 b. 15 c. 20 d. 25

Which of the following property to be turned “yes”
so that value will be auto incremented?

a. Default b. Format

C. Auto value d. Length

Which of the following is not the binary data types?

a. Longvarbinary b. Varbinary

c. Binary d. Charbinary

Which of the following is not the date time data
types?

a. Date b. Time

c. Datestamp d. Timestamp

Which data type is used to store value of fields like
“Date of Birth"?

a. Date Time b. Varchar

C. Integer d. Other

We €an ...ceeeeerireccccrennnnns data in table.
a. modify b. insert

C. delete d. All of these

In which view data can be entered in table?

a. Datasheet view b. Design view

c. Both a. and b. d. None of these

In which mode we can change the structure of table?
a. Datasheet view b. Design view

c. Structure view d. All of these

Sorting means to arrange data in ..o
order.

a. increasing

b. decreasing

C. increasing or decreasing

d. None of the above

In Base data can be linked between two or more
tables with the help of ...........uueevnnaneee

a. Primary Key

b. Farelgn Key

c. Primary and Foreign Key
d. None of the above

Q5L

Relationship can be created between:
a. two tables only b. one table only
c. two or more tables d. Nane of these

Q 52. Relationship between tables can be created from
cssressvasnis TTIGTIHL

a. View b. Insert c. Windows d. Tools

Q53. There are .........cccceuuueeene.. types of relationship
which can be created between tables.
a. three b. two c. four d. Infinite

Q 54. Which language help to extract/fetch data from
table?
a. MySQL b. Python
¢ OpenOffice Base d. HTML

Q55. We can create query (in OpenOffice Base)
a. In design view b. Using wizard
c. Both a. and b. d. Nane of these

Q56. cooeererrieerennnnenenne. Statement is used to retrieve data
from table.
a. Delete b. Update
C. Print d. Select

Q57. .riiiriceeennnnnee.. 1S the most common DML command.
a. Delete b. Update
C Select d. All of these

Q58. ..ccceiieiiieennnnnenn. €lause can be used with the SELECT
statement in SQL to specify which rows to retrieve
from the table. [CBSE2023]
a. WHERE b. GROUP
c SAME d. SIMILAR

Q 59. Which of the following clause return records in
ascending order?
a. Order By b. Where
c. Order Asc d. Order Inc

Q 60. Command to display all the data in the table ‘emp”is:
a. Select ° from emp b. Select ° from emp:
c Selectall fromemp  d. Select all from emp:

Q 6L Which command is used to create table?
a. Select b. Create  c Open d. New

Q 62. Shortcut to execute query in Create Query in SQL
VIEW IS coverriaenssnnenissnaees
a. F7 Key b. F5 Key
C. FB Key d. F6 Key

Q 63. Which command is used to display the salary of all
the employees after incrementing by 10007
a. Select b. Update
C Modify d. Change

Q 64. Select “salary” from emp;

a. will display all the records of table emp

b. will display only particular columns of table emp:
c. will display anly salary column of table emp:

d. None of the above
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Q 65.

Q 66.

Q 67.

Q 68.

Q 69.

Q 70.

Q7L

Q72

Q73.

Q74.

Q75.

Q76.
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Select “empname”, “salary"“ 3 from emp;

a. willIncrease the salary three times of allemployees
in table

b. display name and three times salary

C. give error

d. Nane of the above

To get details about the list of students whose

favourite colour is blue. Query for this is :

a. select all from Stud where fav_Colour='Blue’

b. select name from Stud where fav_Colour='Blue":

c. select ® from Stud where fav_Colour="'Blue’,

d. select all from Stud where fav_Colour is 'Blue’;

Select * from Stud order by “Rollno"” ASC;

a. display all the records of table.

b. display records in increasing order of roll number.

c. Both a. and b.

d. None of the above

Which command is used to modify data in table?

a. Delete b. Select c Modify d. Update
Which command is used to delete data from table?
a. Select b. Delete

C. Insert d. Remove

Command to increase the salary of all employees by
15000.(table name emp and column name sal)

a. update emp set sal = sal + 15000;

b. update emp set sal = 15000:

C. update set sal = sal + 15000:

d. None of the above

By default data is arranged in .....cccccououreeeennnnn. order
using order by clause.

a. ascending b. descending

C. Primary Key d. None of these

Which of the following is DML commands?

a. Insert b. Update
C. Delete d. All of these
R provides a systematic way of

storing information into the database.

a. Report b. Query

c. Form d. Naone of these

A ..oorieiiiieennnneeee. 1S @N interface in a user specified

layout that lets users to view, enter, and change data
directly in database objects such as tables.

[CBSE 2023]
a. frame b. form
c. relatlon d. report
A ..cociiiereienneneoe.. helps to display the data in a
summarised data.
a. Report b. Form
c. Query d. None of these
. SR ...helps to collect specificinformation
from the pcml uf data.
a. Query b. Report
c. Form d. None of these

Q 77. Which of the following is to be created first?

a. Report b. Query

c Farm d. Table

Q 78. Which of the following fields is invalid for storing

information of "Library” Table?

b. Booknumber
d. Dateafbirth

a. Cost
c. Authorname

Q79. A foreign key is a reference of the ............cccconmonannn

key in another table.

a. Alternate
c Candidate

b. Primary
d. None of these

-€) Fill in the Blanks Type Questions N

Q 80.
Q8L
Q82.
Q 83.
e
Q 85.

Q 86.

Q 67.
Q 88.
Q89. .

Q 90.
Q9L

Q 92.

........................... is usually suitable for less amount
of data. (Relational/Flat file) (CBSE 2023)
A i, is a software package that can
be used for creating and managing databases.
A ceeeevrreeeeeeene.. IS @ database management
system that is based on the relational model.

a row in a table.

Composite Key is a combination of ........ccoocciicciiicnan.
columns.

A table is a set of data elements that is organised
using a model of vertical and
horizontal .......cceeeeceriniicnnnnes

A is a set of data values of a particular
type, one for each row of the table.
s represents a single, data item in
a table.

s .. are used to identify which type of
data we are going to store in the database.
................... DDL command is used to create a table.
Common DDL statements are

The types of languages used for creating and

manipulating the data in the Database are
SR~ | [« [

Riemannns .. 1s a standard for commands that

Q 94.
Q 95.
Q 96.
Q97.
Q 98.

Q99.

define the dtfferent structures in a database.
Rosccicansmsmmmpmean is a language that enables users
to access and manipulate data in a database.

is a part of DML involving
information retrieval only.

A popular data manipulation lanquage s
........................... are the baslic building blocks of a
database.

There are .........ccvvvmvnniiersens types of Relationships
in a table.

A..coeerieriiennaennnnen.: NELPS the user to systematically
store information in the database.
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BIHE Boacasananasss enables users to view, enter, and
change data directly in database objects such as
tables.

0L . R statement retrieves zero or more
rows from one or more database tables or database
Views.

Q 102. By default, data is arranged in ..........cccccommmmann
order using ORDER BY clause.

11813 — statement is used for modifying
records in a database.
B civianananaes statement is used to remove one

or more records in a Database.
Q105. To create a form you need to select the
........................... option available under Database

section.

IDG: A cisisnbisiais helps to collect specific
information from the pool of data in the database.

QY s is used to display the summary of
data.

I mmmmscmnnnneds are the interfaces with which the

user interacts.

Q 109. Data from multiple tables can be linked with the
nelp of uccuasuacaans: 80 sacaassmiee
constraints.

'@f Assertion & Reason Type Questions \

Directions (Q. Nos. 110-139): /n the questions given

below, there are two statements marked as Assertion

(A) and Reason (R). Read the statements and choose the

correct option.

a. Both Assertion (A) and Reason (R) are true and
Reason (R) is the correct explanation of Assertion (A).

b. Both Assertlon (A) and Reason (R) are true., but
Reason (R) Is nat the correct explanation of Assertion
(A).

c. Assertlon (A) Is true. but Reasan (R) Is false.

d. Assertion (A) is false. but Reasan (R) is true.

Q 110. Assertion (A): In database, the information is
stored in a structured manner.
Reason (R): Database is an organised collection of
interrelated information of specific type.

Q 111. Assertion (A): Databases can either be maintained
manually or using the computers.
Reason (R): Flat File Based Database Management
System is also known as Flat models.

Q112. Assertion (A): DBMS prevents databases from
authorised access attacks.
Reason (R): DML stands for Data Manipulation
Language.

Q 113. Assertion (A): TCL stands for Transaction Control
Language.
Reason (R): DCL stands for Data Control Language.

Get More Learning Materials Here : &

Q 114.

Q L15.

Q 116.

Q 117.
Q 118.
Q 119.

Q 120.

Ql2l.
Q122.

Q123.

Q 124.

Q 125.

Assertion (A): A Data manipulation language is
used to create and modify the structure of database
objects.

Reason (R): A database model defines the method
of collecting, storing, managing and controlling
the data.

Assertion (A): Object-oriented database models
comprise of varied structures.

Reason (R): A database is a collection of different
objects.

Assertion (A): Forms provide a quick and
convenient way to enter, modify and view records
in a database.

Reason (R): There are only one ways to make a
report.

Assertion (A): Forms can be created using the Form
Wizard.

Reason (R): A report is a graphical object that
presents data in a formatted layout.

Assertion (A): No two fields can have the same
data in the table.

Reason (R): Report presents your data in printed
form.

Assertion (A): Database allows outputting reports
in a printed format.

Reason (R): The wildcard character that matches
any single numeric character is ‘#.

Assertion (A): In addition to viewing data, queries
can also be used to update and sum data in a
database.

Reason (R): The most commonly used query in
Access is the select query.

Assertion (A): The create tab is used to create a
query.

Reason (R): Top pane displays the table(s) to be
used in a query.

Assertion (A): Run option available under the
result group is used to execute the query.

Reason (R): An update query is used to make
changes in the stored in a database.

Assertion (A): The Foreign Key field picks up data
from a Primary Key field.

Reason (R): SQL view option is available under the
Results group to open the SQL view in order to
write SQL commands.

Assertion (A): The index view is used to define the
table structure.

Reason (R): You can establish a relationship
between two tables of a database.

Assertion (A): Relationships option is present on
the formate tools tab.

Reason (R): Data sharing serves as an efficient
handler to balance the needs of multiple
applications using the same data.

@g www.studentbro.in



Q 100.

15 11) FR

Q 102.
o9 (1 < FR
Q 104.

Q 105.

Q 106.
0 111 JET

Q 109.

Amanns ..enables users to view, enter, and
change dala direr:tly in database objects such as
tables.

statement retrieves zero or more
rows from one or more database tables or database
views.

By default, data is arranged in
order using ORDER BY clause.

. statement is used for modifying
records in a database

........................... statement is used to remove one
or more records in a Database.

To create a form you need to select the
... option available under Database

----------------------------

section.
helps to collect specific
information from the pool of data in the database.

: is used to display the summary of
data.
are the interfaces with which the
user interacts.

Data from multiple tables can be linked with the
help of and
constraints.

'@/ Assertion & Reason Type Questions \

Directions (Q. Nos. 110-139): /n the questions given
below, there are two statements marked as Assertion
(A) and Reason (R). Read the statements and choose the
correct option.

QL

Q2.

Q3.

a. Both Assertion (A) and Reason (R) are true and

Reason (R) is the correct explanation of Assertion (A).

b. Both Assertlon (A) and Reason (R) are true, but

Reason (R) is not the correct explanation of Assertion

(A).

c. Assertlon (A) Is true, but Reasan (R) Is false.
d. Assertion (A) is false. but Reasan (R) is true.

Q 110.

Assertion (A):
stored in a structured manner.

Reason (R): Database is an organised collection of
interrelated information of specific type.

Assertion (A): Databases can either be maintained
manually or using the computers.

Reason (R): Flat File Based Database Management
System is also known as Flat models.

Assertion (A): DBMS prevents databases from
authorised access attacks.

Reason (R): DML stands for Data Manipulation
Language.

Assertion (A): TCL stands for Transaction Control
Language.

Reason (R): DCL stands for Data Control Language.

In database, the information is
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Q 114.

Q I5.

Q 116.

Q 17.
Q 118.
Q 119.

Q 120.

Q121
Q122.

Q123.

Q 124.

Q 125.

Assertion (A): A Data manipulation language is
used to create and modify the structure of database
objects.

Reason (R): A database model defines the method
of collecting, storing, managing and controlling
the data.

Assertion (A): Object-oriented database models
comprise of varied structures.

Reason (R): A database is a collection of different
objects.

Assertion (A): Forms provide a quick and
convenient way to enter, modify and view records
in a database.

Reason (R): There are only one ways to make a
report.

Assertion (A): Forms can be created using the Form
Wizard.

Reason (R): A report is a graphical object that
presents data in a formatted layout.

Assertion (A): No two fields can have the same
data in the table.

Reason (R): Report presents your data in printed
form.

Assertion (A): Database allows outputting reports
in a printed format.

Reason (R): The wildcard character that matches
any single numeric character is ‘#.

Assertion (A): In addition to viewing data, queries
can also be used to update and sum data in a
database.

Reason (R): The most commonly used query in
Access is the select query.

Assertion (A): The create tab is used to create a
query.

Reason (R): Top pane displays the table(s) to be
used in a query.

Assertion (A): Run option available under the
result group is used to execute the query.

Reason (R): An update query is used to make
changes in the stored in a database.

Assertion (A): The Forelgn Key field picks up data
from a Primary Key field.

Reason (R): SQL view option is available under the
Results group to open the SQL view in order to
write SOL commands.

Assertion (A): The index view is used to define the
table structure.

Reason (R): You can establish a relationship
between two tables of a database.

Assertion (A): Relationships option is present on
the formate tools tab.

Reason (R): Data sharing serves as an efficient
handler to balance the needs of multiple
applications using the same data.
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Q 126.

Q 127.

Q 128.

Q129.

Q 130.

Q13L

Q132.

Q 133.

Q134.

Q 135.

Q 136.

Q137.

Q 138.
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Assertion (A): Databases can erther be maintained
manually or using the computers.

Reason (R): Searching and retrieving of data is very
difficult in DBMS systems.

Assertion (A): DDL stands for Data Describing
Language.

Reason (R): TCL stands for Transmission Control
Language.

Assertion (A): Adatabase is a collection of different
objects such as Table, Form, Query and Report.
Reason (R): We can browse through records in a
table in Datasheet view using the record navigation
buttons.

Assertion (A): A table is an object of a database.
Reason (R): A query is a question put up on the
database.

Assertion (A): Query can be created using the
Query Design and Query Wizard option.

Reason (R): Forms are used to enter data.
Assertion (A):Formis a question put up on database
tables to view data from a single or multiple tables
at the same time.

Reason (R): Form provides a convenient way to
enter records in a table.

Assertion (A): Forms can be used for inputting
data.

Reason (R): Reports are used to output data.
Assertion (A): Reports can be viewed before final
printing.

Reason (R): Records cannot be edited in a table.
Assertion (A): Reports are used to format,
summarise and compile data in a presentable
manner.

Reason (R): Reports do not allow printing the data
of a database.

Assertion (A): The GRANT command is used to
provide access privileges to database.

Reason (R): The select command is used to make
changes in the data stored in a database.
Assertion (A): The Insert Rows option is present in
the Tools group of the Design tab.

Reason (R): Filters allow you to view only the
records you want to see.

Assertion (A): The Primary Key field can accept null
values.

Reason (R): Referentlal integrity is a system
of rules that MS Access uses to make sure that
relationships between records in related tables are
valid.

Assertion (A): The Foreign Key field uniquely
identifies the records of a table.

Reason (R): The Foreign Key field stores or picks
up the values from a Primary Key field in another
table to relate both table's records to each other.

Q 139.

Assertion (A): Tables can be joined by establishing
a relationship between the tables.

Reason (R): A Select query is used to make changes
in the data stored in a database.

- Answers .
1. (d) 2. (a) 3. (¢ 4. (a) 5. (¢)
6. (b) 7. (¢) 8. (c) 9. (b) 10. (a)

11.(6) 12. (d) 13. (¢) 14. (b) 15. (d)
16. (d) 17. () 18. (d) 19. (d) 20. (a)
21. (b) 22. (b) 23.(d) 24. (c) 25. (a)
26. (c) 27. (a) 28. (d) 29. (b) 30. (a)
31.(b) 32. (d) 33.(d) 34. (a) 35. (a)
36. (a) 37.(d) 38 (a) 39. (d) 40. (a)
41. (a) 42. (c) 43.(d) 44. (¢ 45. (a)
46. (d) 47. (a) 48. (b) 49. (0 50. (c)
51. (¢) 52. (d) 53.(a) 54. (a) 55. (¢
56. (d) 57.(c) 58.(a) 59. (a) 60. (b)
61. (b) 62. (b) 63.(a) 64. (¢ 65. (b)
66. () 67. (b) 68.(d) 69. (b) 70. (3)
71. (a) 72.(d) 73.(c) 74. (b) 75. (3)
76. (a) 77.(d) 78.(d) 79. (b)

80. Flat File 81. DBMS

82. RDBMS

83. Microsoft Access, OpenOffice Base, MySQL

84. Primary Key 85. one or more

86. columns, rows 87. column

88. row 89. Datatypes

90. Create table 91. create, alter, drop

92. DDL, DML 93. DDL

94. DML 95. Select

96. SQL 97. Tables

98. three 99. form

100. form 101. SELECT

102. ascending 103. UPDATE

104. DELETE 105. form

106. query 107. Report

108. Forms 109. Primary Key, Foreign Key
110. (b) 111. (b) 112. (d) 113. (b) 114. (d)
115. (b) 116. (c) 117. (b) 118. (d) 119. (b)
120. (d) 121. (b) 122. (b) 123. (b) 124. (d)
125. (d) 126. (c) 127. (d) 128. (d) 129. (d)
130. (b) 131. (d) 132. (b) 133. (¢) 134. (¢)
135. (c) 136. (b) 137. (d) 138. (d) 139. (¢)

‘@ga Case Stl.ldv Based Type Questions N\

Case

Study 1

Database: A database is an organised collection
of interrelated information of a specific type.
In the database, the information is stored in a
structured manner that makes 1t quick and easy
to find information. We use and maintain various
databases 1n our day-to-day life. For example,
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a telephone directory, in which we store
contact details of our friends and relatives in an
alphabetical order; a school diary, in which we
keep a record of the daily homework assignments
day and date-wise; and even a dictionary, in which
meanings of the words are arranged alphabeucally.
Database can either be maintained manually
or using the computers. In earlier times, many
organisations used to create and maintain the
database manually, but with the introduction
of DBMS (a computerised way of creating and
maintaining databases), the traditional way of
creating and maintaining databases manually,
i1s completely replaced by the computers.
Some examples of computerised databases are
computerised library systems, flight reservation
systems, computerised inventory systems, etc.

QL Which one of the following is used to define the
structure of the relation, deleting relations and
relating schemas?

a. DML(Data Manipulation Language)
b. DDL(Data Definition Language)

C. Query

d. Relational Schema

Q 2. Which one of the following provides the ability
to query information from the database and
to insert tuples into, delete tuples from, and
modify tuples in the database?

a. DML(Data Manipulation Language)
b. DDL(Data Definition Language)
C. Query
d. Relational Schema
Q 3. CREATE TABLE employee (name VARCHAR, id

INTEGER)

What type of statement is this?

a. DML b. DDL

c. View d. Integrity constraint

Q4. SELECT " FROM employee
What type of statement is this?

a. DML b. DOL
C. View d. Integrity canstraint
Q5. The basicdata type char(n)isa............... length

character string and varchar(n) is ...ccccecei..
length character.

a. fixed. equal
c. fixed. varlable

b. equal. variable
d. varlable, equal

Answers *

1. (b) 2. (a) 3. (b) 4 (a) 5. ()

Case Study 2
KEYS IN DBMS:

e Primary Key: A primary is a column or set
of columns 1n a table that uniquely 1dentifies
tuples (rows) in that table.
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e Super Key: A Super key is a set of one or more
columns (attributes) to uniquely identify rows
In a table.

* Candidate Key: A Super key with no redundant
attribute 1s known as a Candidate key.

* Alternate Key: Out of all Candidate keys, only
one gets selected as Primary key, remaining
keys are known as alternate or secondary keys.

* Composite Key: A key that consists of more
than one attribute to uniquely identify rows
(also known as records & tuples) in a table is
called composite key.

* Foreign Key: Foreign keys are the columns of
a table that points to the Primary key of another
table. They act as a cross-reference between

tables.
Q1 Which one of the following allows us to
uniquely identify the entity in the entity set?

a. Domain b. Tuple
c. Row d. Key
Q2. A s is a set of one or more

attributes that, taken collectively; allow us to

identify uniquely an entity in the entity set.
a. Primary Key b. Super Key

c. Candidate Key d. Forelgn Key

Q 3. A Super keys for which no proper subset is a

super key. Such a minimal Super keys are called

!!!!!!!!!!!!!!!!!!!!!!!!

a. Primary Key b. Super Key

c. Candidate Key d. Foreign Key

Q4. ......ccceviiiiveeneenne IS the columns of a table that

points to the Candidate key of another table.
a. Primary Key b. Super Key

c. Candidate Key d. Fareign Key

55 [ prme—— should be chosen such that

its attributes are never, or very rarely changed.
a. Primary Key b. Super Key

c. Candidate Key d. Forelgn Key

Answers 2

1. (d) 2. (b) 3. (¢ 4. (d) 5. (a)

Case Study 3

Working with Queries: A Query 1s an Access
object using which you can get answers to
questions about the data. A query can involve a
single table or multiple tables. Queries let you
pick up data from one or more tables at the same
time. In addition to viewing data, queries can also
be used to update and add data in a database.
Types of Queries: The types of queries that can
be created in MS Access, are as follows:
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Update: An Update query is used to make
changes in the data stored in a database. An
update query lets you update multiple records
of a table at the same time.

Make Table: A Make Table query works the
same way as an Update query works but the only
difference is that it puts the results in a new table.
Append: An Append query lets you select
records from one table and add them to the end
of another table.

Delete: A Delete query is extremely useful, but
care needs to be taken while using it. This query
lets you select and delete records from a table.
Select: The most commonly used query in
Access is the Select query. It allows you to
view specific data either from one table or
from multiple tables, simultaneously. Select
query lets you view selected records satisfying
a condiuon from a database.

QL Table Employee has 10 records. It has a non-

Q2.

Q3.

Q4.

Q5.

NULL SALARY column which is also UNIQUE.

The SQL statement

SELECT COUNT(") FROM Employee WHERE
SALARY > ANY (SELECT SALARY FROM
EMPLOYEE); prints

a. 10 b. 9 €5 g

TheSQLstatement-SELECTSUBSTR('abcdefghij),
INSTR('123321234, '2), 3, 2), 2) FROM DUAL;
Prints

a. gh b3 e.be d.ab

The SQL statement - SELECT ROUND(45.926,
-1) FROM DUAL,;

a. is illegal b. prints garbage

C. prints 045.926 d. prints 50

In an SOQL SELECT statement querying a single

table, according to the SQL-92 standard the

asterisk (*) means that:

a. all columns of the table are to be returned.

b. all records meeting the full criteria are to be
returned.

c. all records with even partial criteria met are to
be returned.

d. None of the above Is correct

The HAVING clause does which of the following?

a. Acts EXACTLY like a WHERE clause.

b. Acts like a WHERE clause but is used for
columns rather than groups.

c Acts like a WHERE clause but is used for
groups rather than rows.

d. Acts like a WHERE clause but Is used for rows
rather than columns.

Answers ®
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Case Study 4

CREATE TABLE command: The CREATE

TABLE command is used to create a table in a

database. In addition to creating a table either in

the Design view or in the Datasheet view, a table

can also be created using the CREATE TABLE

command of SQL.

» INSERT command: The INSERT command
1s used to add records to a table.

e SELECT command: It allows us to view the
records from a table.

* UPDATE command: An UPDATE command
1s used to make changes in the data stored in
a database. An UPDATE query lets us update
multiple records of the table at the same time.

* DELETE command: The DELETE command

query lets us select and delete records from a

table.

QL AnSQL INSERT statement adds.............. records
to any single table in a relational database.
d. one b. one or more
C. only two d. None of these

Q2. The SELECT statement used in an INSERT
SELECT can include a ............... clause to filter
the data to be inserted.
a. where b. from
C. into d. Both a. and b.

Q3. SELECT INTO copies data into a............... table.
a. old b. new

c. only system table d. Both a. and b.

Q4. The SOL ............... statement can be used to
create backup copies of tables.
a. SELECT IN b. SELECT TO
c. SELECT IO d. SELECT INTO

Q5. What is this below query doing:

select distinct el."FirstName”

into NewTable

from "employee” el

a. The query returns all names from the field
"FirstName® Including duplicates and places it
inside a new table giving it name "NewTable".

b. The query returns all names from the field
"FirstName' excluding duplicates and places it
Inside a new table giving it name "NewTable".

c. The query returns all names from the field
*FirstName" excluding duplicates and places it
Inslde a new table giving it name *mynewtable’

d. Both a. and b.

o Answers °

1. (b) 2. (a) 3. (b) 4 (d) 5. (b)
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Case Study 5

(c) (d)

Consider the table STUDENTS given below: Gender Marks Gender Marks
Roll No| Name |[Class| DOB Gender City Marks F 256 3 492
F 324 F 470
] Anand | XI | 6/6/97 M Agra 430
F 740 F 324
2 | Chetan| Xl | 7/5/94 M Mumbai | 460 . 492 r 556
J Geet Xl | &/5/97 - Agro 470 Q 3. Prachi has given the following command to
4 Preeti | XIl | 8/8/95 F Mumbai | 492 obtain the highest marks
5 | sanival| XiI |8/10/95 M Delhi 360 Select max(marks) from student where group
by class;
6 |Maakhiy| XI |12/12/94| F Dubai | 256 but she is not getting the desired result. Help
7 Neha | X |8/12/95]1 F | Moscow | 324 her by writing the correct command.
5 Nishant | % 12/6/95 M Moscow | 429 a. Select max (marks) from student where group
by class:
Q 1. State the command that will give the output as: b. Select class, max (marks) from students
Kisran group by marks:;
—" c. Select class. max (marks) group by class from
= students;
= d. Select class. max (marks) from student group
Geet by class;
Preetl Q4. State the command to display the average
(1) select Name from STUDENTS where Class = marks scored by students of each gender who
‘XI'and Class = XII'; are in Class XI?
(1) select Name from STUDENTS where not (1) Select gender, avg(marks) from student
Class = XI'and Class = XII'; _ where class = "XI" group by gender;
(1) felecﬁ Nam.e fruum STUEENTS where city = (I) Select gender, avg(marks) from student
Agra™OR city = "Mumbai™; ) where group by gender where class = “XI";
(IV) select Name from STUDENTS where city IN
(“Agra”, “Mumbai”); (111) Select gender, avg(marks) group by gender
Choose the correct option: from student having class =" XI";
3 [and B 1 ard IV (IV) Select gender, avg(marks) from student
c. 1.l and IV d. Only i group by gender having class ="XI";
Q2. What will be the output of the following Choose the correct option:
command? a. lland lll b. Il and IV
Select *from student where gender ="F” order by c landlll d. Only I
marks;
(a) s Answers o
Roll No| Name |Class| DOB Gender City Marks 1. (b) 2. (b) 3. (d) 4. (b)
4 Preeti | XIl | 8/8/95 F Mumbai | 492
Case Study 6
3 Geet Xl | 6/5/97 F Agra 470
Tejasvi Sethi, a car dealer has stored the details
7 Neha X 18/12/95 F Moscow | 324 ; i
. . of all cars in her showroom in a table called
6 [Maakhiy| XI |12/12/34] F Dubai | 256 CARMARKET. The table CARMARKET has
(b) attributes CARCODE which is a primary key,
Roll No| Name |Class DOB Gender City Marks CARNAME, COMPANY, COLOR, COST ('m
6 |Maakhiy| XI [12/12/94| F Dubai | 256 lakh rupees) of the car and DOM which is the Date
7 | Neha | X |812/95| F | Moscow | 324 OF Blansipes0r thie car
5 Geet | X1 | 6/5/97 - Agra | 470 Answer any four questions based on the'tab]c
. ‘ CARMARKET from the below mentioned
4 Preeti | XIl | 8/8/95 F Mumbai | 492 questions:
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Table: CARMARKET

Carcode| Carname | Company | Colour | Cost DOM
CO1 | BALENO | SUZUKI | BLUE | 590 | 2019-11-07
CO2 [ INDIGO TATA | SILVER |12.90 [ 2020-10-15
Co3 GLC |MERCEDES| WHITE |62.38(2020-01-20
CO4 AB AUDI RED |58.55]| 2018-12-29
CO5 | INNOVA | TOYOTA | BLACK [32.82] 2017-11-10
CO6 |WAGON-R| SUZUKI | WHITE | 1211 | 2016-11-11
CO7 | BREZZA | SUZUKI |GOLDEN]| 9.80 |2016-10-03

Choose the correct SQL query to do the following:

QL Display the carname along with the charges
rounded off to 1 digit after decimal place.

a. Select Carname, round (Cost) from CARMARKET:
b. Select Carname. round.Cost (1) from CARMARKET:;
c. Select Carname. round.Cost () from CARMARKET:
d. Select Carname.round (Cost.1) from CARMARKET;

Q 2. Display the carname, colour and position of the
character 'E'in the colour of all the cars.
a. Select Carname., Colour fram CARMARKET
where Colour like “96E96";
b. Select Carname. Colour. Instr(Colour. 'E') from
CARMARKET;
c Select Carname. Colour from CARMARKET
where Colour = "96E%:";
d. Select Carname, Colour, substr (Colour, 1. 'E)
from CARMARKET:

Q 3. Display the Carname, Name of the company in
lower case of all cars whose year (of DOM) is
2020.

a. Select Carname. lcase (Company)
CARMARKET where year (DOM) = 2020:
b. Select Carname. lcase (Company) from
CARMARKET where year of (DOM) like '20209%";

. Select Carname lower (Company) from
CARMARKET where DOM from "2020-01-01" to
*2020-12-31%

d. Select Carname. lower (Company) from
CARMARKET where year from (DOM) = 2020

Q 4. Display the number of cars manufactured each
year.

a. select count (*), year (DOM) from CARMARKET
where year (DOM) = distinct;

b. select count (°), year (DOM) from CARMARKET
group by year (DOM):

from

c. select count (Carmarket). year (DOM) from
CARMARKET group by year (DOM):;

Case Study 7
Write the queries for the following table: Emp

Emp_id Ename Salary
1 Suman 20000
2 San|ay 32000
3 Ravi 30000

QL Display the salary of all the employees after
incrementing by ¥1000.

Q 2. Display the Employee id and salary of all the
employees after decreasing by < 500.

Q 3. Display the name and salary of all the

employees after incrementing it as thrice the

amount of present salary.

Display the Employee id, Name and salary of all

the employees after decrementing it as half the

amount of present salary.

Q4.

o Answers °

Select Salary +1000 from Emp:

Select Emp_id. Salary = 500 from Emp:

Select Ename. Salary ° 3 from Emp:

& w N o

Select Emp_id, Ename, Salary/2 from Emp;

Case Study 8
Write the queries for the following table: Student

Class

House
Blue

Admno Name

1001
1002
1003

Q 1L Display the entire table.
Q 2. Display the list of students whose house colour
is blue.

Q 3. Display the admission number of students
whose house colour is green.

Sonam 9
Ravl 10

Yellow

Poonam 10 Green

Q4. Toviewrecords in ascending order of Admission
Number.
e Answers °
1. Select ® from Student
2. Select ? from Student where House = "Blue®
3. Select Admno from Student where House = *Yellow”
4. Select * from Student order by Admno Asc.
Case Study 9

Write the queries for the following table: Student

d. select count (distinct (°), year (DOM) from RollNo Name Class House
CARMARKET group by year (DOM); 2001 | Birssnchy g Bisie
. Answers > 7002 Rohit 7 Yellow
1.(d) 2. (b) 3. (a) 4. (b) 7003 Gaurav S Green
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Q L Display the records of Class 9 Students.

Q 2. Display the class of ‘Rohit’.

Q3.
Q4.

Insert the given record: 7004,"Aman”, 11, Blue”
Display the Roll number of students whose
house colours is Blue.

Answers 5

Select ° from Students where Class = 9:

Select Class from Student where Name = 'Rohit’.
Insert into Student values( 7004, "Aman”. 11, “Blue”).

Select RollNo from Student where House = *Blue®

» W N

Case Study 10

Write the queries for the following table: Item

Q2.

Q3.

Q4.

itemno Iname Price

Qty
12 Pen 10 17
13 Eraser 5 15

14 Notebook 15 20

Q1 Write aqueryto insert a new record of following

details 15, “Pencil”, 20, 10.

Write a query to display detail of items whose
quantity is more than 10.

Write a query to change the quantity of Item
number 13 to 25.

Display the total amount of each item. The
amount must be calculated as the price
multiplied by quantity for each item.

Answers g

Insert Into Item values(15. "Pencil’. 20, 10).
Select * from Item where Qty > 10.

Update Item set Qty = 25 where Itemno = 13.
Select Price ® Qty from Item.

£ W N

-) Very Short Answer Type Questions N

Ql

Ans.

Q2.

Ans.

Q3.
Ans.

What is a database?
A database [s an organised collectlon of Interrelated
iInformation of a specific type. In the database. the
information Is staored in a structured manner that
makes it easy to find information.
Name any four categories of DBMS.
The four categaries of DBMS are as follows:

(i) Flat file based DBMS.

(II) Hierarchical database management system.

(iii) Network database management system.

(iv) Relational database management system.

What do you mean by Flat File DBMS?

Flat File Based Database Management Systems, also
known as flat models, are the simplest database
management systems. These store information in

Get More Learning Materials Here : &

Q4.

Ans.

Q5.

Ans.

Q6.

Ans.

Q7.

Ans.

Q8.

Ans.

Q9.

Ans.

Q 10.
Ans.

Q1L

Ans.
Q12.

Ans.

Q13.

Ans.

flat files having rows and columns to store data.
Flat files cannot be linked to each other.

Write one example each of Flat File DBMS and
Hierarchical DBMS.

Flat File DBMS example: MS Excel

Hierarchical DBMS example: XML document.

What is the use of a Flat File based database?
Flat File based database stores Information In flat
files having rows and columns to store data. Flat
files cannot be Unked to each other.

Discuss object-oriented DBMS.

In object-oriented database management systems.
the object and its data or attributes are seen as
one and accessed through pointers. Object-oriented
database models comprise varied structures and
are quite extensible.

Name the database model which are used rarely
because of complex data structure and also write
the name of database model by which it is replaced.
Network database management system model are
rarely used because of the complex data structure
and have been replaced by Relational Database
Management System.

Write some examples of object-oriented DBMS
and Relational DBMS.

Object-oriented DBMS examples: |IBM db40 and
DTS/S1.

Relational DBMS examples: MS Access, Oracle, MS
SQL Server and MYSQL.

What is the most commonly used SQOL command?
What is it used for?

The most commonly used SQL command is the
SELECT command. It allows us to view the records
from a table. It also lets us view selected records
satisfying a condition from a table.

What do you mean by the term data manipulation?

Data manipulation means to perform different
operations such as to view the records, to edit and
update the records and to delete the records stored
in a database when needed.
Mention any two integer data types of a table field
in database. [CBSE SQP 2022, Term-2]
TINYINT, SMALUINT, INTEGER, NUMERIC, BIGINT
Name the relationship in which one column of
the primary key table is associated with all the
columns of the associated table and vice-versa.
One to Many Relationship or Many to One
Relatlonship. [CBSE SQP 2022, Term-2]
Define Reports of a database.

[CBSE SQP 2022, Term-2]
A report helps to display the data in a summarised
manner. It is used to generate the overall work
outcome In a clear format. You can create reports In
the database.
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Q 14. When the primary key constraint is applied to one
or more columns in a table is known as....................

Ans. Composite Primary Key [CBSESQP 2022, Term-2]

Q 15. Arow that represents a single, data item in a table
15 RROWN A8 s

Ans. record or tuple

Q 16. Explain the term sorting.

Ans. Sorting refers to arranging the table data in Increasing
or decreasing order. [CBSESQP 2022, Term-2)

Q 17. Describe CREATE command.

Ans. This command defines the structure of a table. It
describes the kind of data to be stored In a table
by declaring the number of fields, field name. field
length and the data type of fields of a table.

Q 18. Differentiate between TRUNCATE command and
DROP command.

ANS. TRUNCATE command: This command removes all
the table records including allocated table spaces.

[CBSE SQP 2022, Tarm-2]

DROP command: This command deletes a table or
other database objects such as index or view.

Q19. What do you mean by SET TRANSACTION
command?

Ans. SET TRANSACTION command is used for specifying
characteristics such as the read-write/read-only
access, etc., for a transaction.

Q 20. What is a record?

Ans. A row containing all the data about a single item of
the object Is called a record.

Q 21. Define table. Also write its characteristics.

Ans. A table Is a grid made up of rows and columns that
stores all the data about a single object
Characteristics of a Table:

(i) Each table must have a unique name.

(i) Each field of table must have unique name and
data type.
Q 22. Name the two views for table.
Ans. The two views for the table are as follows:
(i) Design view (i) Datasheet view
Q 23. Write rules and regulations for the table name.

Ans. A table name should not exceed 64 characters. A
table name can only Includes spaces. letters and

numbers.
Q 24. What is a query?
Ans. A query Is a question put up on the database to view

the records, matching the criteria defined by us.

Q 25. What are the two methods to create a query?

Ans. A query can be created using either of the following
methods:

(i) Using Query Wizard

(if) Using Query Design
Q 26. Name the two panes of the Query Design window.

Ans. The Query Design window is divided into two panes:
Top pane and Bottom pane.

Q 27. What is the use of the Field option present on the
Query Design grid?

Ans. Field option displays the field of a table to be
included in the query.

Q 26. What is a report?

Ans. A report is a graphical object that presents data in a
formatted layout. This Is useful for displaying data
in an organised manner and for printing,

Q 29. Write any two characteristics of report.

Ans. The two characteristics of report are as follows:

(I) Access enables us to ceate a report either from
table or query.

(i) Reports can be viewed befare final printing,

Q 30. What is a wizard?

Ans. A wizard conslsts of a sequence of screens through
which we navigate In order to achleve a specific task.
such as, creating a query,.

Q 31. Define the following terms:

(i) Macro (i1) Code
Ans. (i) Macro: A set of actions created to automate

common tasks is known as Macro.

(ii) Code: A code refers to the declarations. statements
and procedures written in the programming
language.

Q 32. How is database maintained?

Ans. Database can be maintained either manually or
by using the computers using DBMS (Database
Management System).

Q 33. Write some examples of computerised databases.

Ans. Some examples of computerised databases are
computerised library system, flight reservation
system, computerised inventary system, etc.

Q 34. What does a database model defines?

Ans. A database model defines the method of collecting.
staring, managing and controlling the data.

Q 35. What is the purpose of Title bar?

Ans. Title bar Is present at the top of the window that
displays the name of the current database.

Q 36. Write the steps to close a database.

Ans. Perform the below mentioned steps to close a
database file:
Step 1: Click an File tab and click on Close database
Step 2: The current database gets closed and the

new option becomes selected on the Flile tab.

Q 37. Define how to switch between the Design view and
the Datasheet view.

Ans. Toswitch between the Design view and the Datasheet
view, click on the View arrow on the Home tab and
click on either Datasheet view or Design view. to
select a view to wark.
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Q 36.
Ans.

Q 39.

Ans.

Q 40.

Ans.

Q4l.
Ans.

Q 42.
Ans.

Q 43.
Ans.

Q 44.
Ans.

Q 45.
Ans.

Q 46.
Ans.

Q 47.
Ans.

Q 48.

Ans.

Q 49.

Ans.

Q 50.

What do you mean by Rich text data type?

Rich text is used to store text or combinations of
text and numbers that can be formatted using

colour and font options.

Explain Memo datatype.
Memo Is used to stare long block of text. It can store

upto 65,535 characters.

Differentiate between Validation Text and Validation
Rule.

Validation Rule: It limits the value that the field will
accept.

Validation Text: It Is the error message that appears

when we enter the wrong value.

What do you mean by Toggle filter?

Toggle Filter option allows us to turn the filter on
and off. To view records without the filter. simply
clck on the Toggle Filter option. To restore the filter,
click it again.

Explain how can you remove a filter.

To remove a filter, click on the Toggle filter option in

the Sort and Filter group to remove a filter.
Describe the [] character and ! character.

[] character: It matches characters within the brackets.
I character: It excludes characters inside the brackets.
Define wildcards.

Wildcards are special characters that can stand in
for unknown characters in a text value.

What is the purpose of Status bar?
The Status bar is present at the bottom of the

window. On its right side. four view buttons are

present—datasheet view, design view, pivot table

view, pivot chart view.

Name the two types of fields that are used to join
two tables.

Primary Key field and Forelgn Key field are used to
join two tables.

Define Foreign key.

The Foreign key field is a field that stares or picks up

the values from a Primary key field in another table
to relate both tables' records to each other.

How can you establish a relationship between two
tables?

We can establish a relationship between two tables
of a database using a common field that exists in

both the tables.

What are the different kinds of relationships
between tables?
There are three kinds of relationships between tables:
(I) One-to-many relationships
(i) Many-to-many relationships
(ili) One-to-one relationships
Write the correct syntax of SELECT command.

. The syntax of the SELECT command Is as follows:

SELECT column 1, column 2 ..... ., column N from

<table_name> ;
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Q SL. Write the correct syntax of DELETE command.

Ans. The syntax of the SQL DELETE command Is as
follows:

DELETE FROM <table_name>
WHERE (condition);
Q 52. Write the keyboard shortcut keys for the following:
(i) To move the previous field.
(ii) To open the help window.
Ans. (i) Press Shift + Tab keys to move to the previous
field.
(i) Press F1key to open the Help window.
common] ERR(DR »
Students give incorrect syntax of commands so rhey]
should learn all the commands thoroughly.
Write the purpose of DBMS.
DBMS Is used to stare logically related information
at a centralised locatlon. It facilitates data sharing
among all the applications requiring it.
Write the relationship between a database and a
table.
A database contains multiple tables whereas, a
table cannot exist outslde a database.
Give any one use of database.
A database is used to store logically related
Information In table.
What is field in database? Give an example.
A field is an area. reserved for a specific piece of data.
It Is also known as attribute, e.g.. Customer_Name.
State the primary goal of a DBMS.
To provide a convenient and efficlent environment
In which we can store and retrieve information.
Write any two uses of database management
system.
(i) DBMS Is used to store data at a centralised location.
(ii) It Is used to minimize data redundancy and data
inconslistency.
Give any two disadvantages of the database.
Ans. (i) High complexity (ii) Database failure
Q 60. Write any two advantages of using database.
Ans. (i) Can ensure data security.
(1) Reduces the data redundancy.
Q 61. What is a primary key?
Or
Define primary key with an example.
Or

What is primary key? Give an example.
Or

What is a primary key in database? Give an example.

Ans. A field which uniquely identifies each record in
a table is known as primary key. e.g. empld Is the
primary key of the Employee table.

Q 62. Give one advantage of using primary key.

Ans. A primary key uniquely identifies the record in the
table.

Q 53.
Ans.

Q54.

Ans.

Q SS.
Ans.

Q 56.
Ans.

Q 57.
Ans.

Q58.

Ans.

Q 59.
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Q 63.
Ans.

Q 64.
Ans.

Q 65.

Ans.

Q 66.
Ans.

Q 67.
Ans.

Q 68.
Ans.

Q 69.
Ans.

Q 70.
Ans.

Q7L

Q72

Ans.
Q73.
Ans.

Q74.
Ans.

Q75.
Ans.

Q76.

Ans.

Q77
Ans.
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What is the significance of a primary key?
A primary key cannot allow null values and must
have a unique index.

Name two possible primary keys for an Employee
table.

Possible primary keys for an Employee table are
empcode. empphonenumber.

Write the significance of a foreign key.
A forelgn key Is used to establish relationship
between any two tables of RDBMS.

Name two DBMS Software.
Two DBMS Software are;
() MySQL (i) Oracle
() Microsoft SQL Server (lv) Microsoft Access
What do you mean by database servers?

Database servers are dedicated computers that
hold the actual databases and run only the DBMS
and related software.

Write four advantages of database.

Four advantages of database are:

(1) It reduces data redundancy.

(ii) It allows sharing of data.
(i) It help to maintain data integrity.
(iv) It provides data security.

What do you mean by data type?

Datatypes are used to identify which type of data
(value) we are going to store in the database.

What do you mean by data redundancy?
Duplication of data In a database Is known as data
redundancy.

What is the difference between Char and Varchar
data type?

. Char is a fixed length data type and Varchar Is a

variable length data type.
Data in a (RDBMS) is organised in the form of

Tables

What do you mean by data integrity?

Data Integrity means that the data Is accurate and
consistent in the database.

What is data consistency?

Data consistency means there should be multiple
mismatching copies of the same data in a database.
Write two features of database.

Two features of database are:

(i) A database can have one ar many tables.

(Il) Every table in a database has a primary key
fleld which ensures 009 unique values In the
database.

What is primary key?

A field which is unique for each and every record in
a table is called primary key.

What do you mean by composite primary key?
When primary key constraint is applied on one
or more columns then it is known as composite
primary key.

Q 78.
Ans.

Write rules and requlations for the table name.

A table name should not exceed 64 characters.
A table name can only include spaces, letters and
numbers.

“é@ Short Answer Type Questions N

QL

Ans.

Q2.

Ans.

Q3.

Ans.

Q4.

Ans.

Q5.

Ans,

Discuss some features of database.
Some features of database are as follows:
(I) It creates and stores data In the form of tables.
Tables are easy to work with.
(I) It can handle a large number of records stored
in the tables.
(iii) Itis best used for a long-term data storage and/

ar data sharing.

(iv) It allows multiple users to use the database.
simultaneously.

Write any two advantages of database.

Two advantages of database are:

() Database provides a strong framework to

protect data privacy and security.

(i) Database provides the capability to access the
frequently accessed data as quickly as possible.

What is Database Management System (DBMS)?

A Database Management System (DBMS) is an

application program that is used to create and

maintain the database. It enables users to store,

modify and view information from a database as per
the requirements. It provides a systematic approach
to create, retrieve. update and manage information
in a database. DBMS also prevents databases from
unauthorised access. It is quite easy and simple to
use DBMS.

Differentiate between Hierarchical DBMS and
Network DBMS.

Hierarchical DBMS: Hierarchical Database Management
Systems function on the parent child tree-lke
model These store the data items along with the
description of the data items. such as a book with
infarmation on chapters and verses.

Network DBMS: Network Database Management
Systems use a data model similar to Hierarchical
Database Management Systems. The major

difference between the two is that the tree structure
in the Network models can have a many parent to
many child relational model. The Network model
structure Is based on records and sets.

What do you mean by RDMS?

Relational Database Management Systems are
the most widely used database management

systems, today. These are relatively easy to use.
These stare the information in the form of tables.
Relational Database Management Systems are
named so because of the capability to link multiple
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data structures, ie., tables. MS Access, Oracle, MS

5QLServer, IBM DB2 and MySQL are some of the
commonly used Relational Database Management
Systems.

How Entry Required and Default Value properties
of a table field in a database are different from
each other? [CBSESQP 2022, Term-2]
Entry Required: If set to yes then it will be necessary
for the user to insert the value in the field which
means that field cannot be left blanlc

Default Value: A default value can be set for a field
if user don't provide any value while entering the
values in the table.

What is Referential Integrity? Explain its two (any)
purposes. [CBSESQP 2022, Term-2]
Referential Integrity is used to maintain accuracy
and consistency of data in a relationship. In Base.

data can be linked between two or more tables with
the help of primary key and foreign key constraints.

Referential integrity helps to avoid:

(I) Records can be added to a related table. if there
is no associated record available in the primary
key table.

(ii) The values can be modified in a primary if any
dependent records are present In the assoclated
table(s).

(i) Deleting records from a primary key table if
there are any matching related records available
In assoclated table(s).

What Is the difference between forms and reports?

[CBSESQP 2022, Term-2]

Forms provides an interface to users to view. add.

modify in both table and queries.

Reports are presented forms used to present

formatted summaries or lists of the data from one

or more tables or queries.

Identify the columns and data types of a table:
Airlines. Mention at least four columns with data
type. [CBSESQP 2022, Term-2]

Ans.

Q6.

Ans.

Q7.

Ans.

Q8.

Ans.

Q9.

Columns Data Type

Flight No Text

No. of Passengers Integer

Alrlines Text

Arrival Time Date/ Time

Departure Time Date/Time

Fares Float

Q 10. Explain any two types of relationships that can be
created in tables. [CBSESQP 2022, Term-2]
OpenOffice base support 3 types of relationships:

() One-to-One (ll) One-to-Many or Many-to-One

(i) Many-to-Many

Ans.
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One-to-One: In this relationship both tables
must have primary key columns. Example:
In the given tables emp and dept. empno
and deptno is primary key in dept table. So.
in relationship these two fields are used for
one-to-one relationship.

(ii) One-to-Many or Many-to-One: In this kind
of relationship one of the table must have
primary key column. It means that one column
of primary key table is assoclated with all the
columns of assoclated table. As above example.,
emp and dept tables. empno is primary key for
the emp table.

(iii) Many-to-Many Relationship: In this kind of
relationshlp no table has primary key column.
It means that all the columns of primary key
table are associated with all the columns of
assoclated table.

Identify any two column name/attribute and their

data types from a given table: PLAYER

QIL

PID PNAME | RUNS | GENDER | DOB

P101 | Sachin 13000 M 10/04/2001
P102 | Kapil 7000 M 12/02/1998
P103 | Saurabh | 12000 M 13/04/2001
P104 | Virat 12500 M 17/03/2005

[CBSE SQP 2022, Term-2]

Ans. PID - Char(4), Primary Key
Pname - varchar(10)

Runs - int(5)

Gender - cahr(1)

DOB - Date

Q 12. Give the disadvantages of a database system.
Ans. The disadvantages of a database system are as
follows:

() Cost of Hardware and Software: Through
the use of a database system. new costs are
generated due to additional hardware and
software requirement.

(ii) Database Failure: If database is corrupted due
to power failure or it Is corrupted on the storage
media, then our valuable data may be lost or
the system will stop working.

Q 13. What are the four different computer languages

that are used to manipulate the data stored in a
database?
The four different types of computer language that
are used to manipulate the data stored in a database
are as follows:

(i) Data Definition Language (DDL)

(i) Data Manipulation Language (DML)
(ili) Data Control Language (DCL)
(iv) Transaction Control Language (TCL)

Ans.
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Q 14. Distinguish between DDL and DML.
Ans. Difference between DDL and DML.

Basis of
S.No. e — DDL DML

abbreviation of| abbreviation of
Data Definition| Data Manipulation

Language. Language.

(i) |Purpose It is wused tollt is wused to
create and modify|retrieve, store,
the structure of|maodify, delete,

database objects in|insert and update
database. data in database.

commands| DML commands

(i) | Benefits DDL
allows us tol are used for

perform tasks| manipulation  of
related to data|data.
definition.

(iv) | Example For example:| For example:
CREATE,  ALTER,|SELECT, UPDATE,
and DROP|and INSERT
commands. commands.
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G- TiP
Give the difference in tabular form and provide examples
of both types of commands.

Q 15. Define CREATE Table command.

Ans. The CREATE TABLE command is used to create a
table in a database. In addition to creating a table
elther In the Design view aor in the Datasheet view. a
table can also be created using the CREATE TABLE
command of 5QL in MS Access 2010.

Q 16. Describe the following commands:

(i) ROLLBACK command
(ii)) SAVEPOINT command
(iii) UPDATE command
(iv) DELETE command
Ans. (i) ROLLBACK command: This command Is used to
restore the transaction in the case of any error.
(i) SAVEPOINT command: This command is used
for setting a savepoint within a transaction.
(i) UPDATE command: This command Is used to
edit and update the records in a database.
(iv) DELETE command: This command is used to
delete the data stored in a database.

Q 17. What is Data Control Language?

Ans. The Data Control Language (DCL) Is used to control
the access and permission given to the users of a
database. The examples of DCL commands are
GRANT and REVOKE.

() GRANT command: This command s used to
provide access privileges to database.

(i) REVOKE command: This command is used to
withdraw user's access privileges to database.

Q 16. Define any two types of users which can access the
database system.

Ans. The two types of users which can access the
database system are as follows:

(i) Database Administrator (DBA): A person, who
is responsible for managing or establishing
policies for the maintenance and handling the
overall database management system Is called
DBA.

(i) Applcation Programmer: A person. who writes
application programs in programming language
to interact and manipulate the database are
called application programmer.

Q 19. Write the steps to use wildcard characteristics in
queries.

Ans. Perform the below-mentioned steps to use wildcard
characters In querles:

Step 1. Open the query In the Deslgn view.

Step 2: In the Criteria row of the field that we want

to use, type the operator Like in front of our
criteria.

Step 3: Replace one or more characters In the criterla
with a wildcard character. for example Lke
R?308 will return RA308. RB308 and so on
Step 4: On the Design tab. click on the Run button
to pet the output.
Q 20. Discuss any two options in the picture type property.
Ans. The two options In the picture type property are as
follows:
(I) Shared Property: The picture will add the image
to pallery.
(Il) Linked Property: The Image will not get displayed
on changing the path of the picture.
Q 21. Differentiate between Design View and Datasheet
View.
Ans. Deslgn View: It Is used to define the table structure.
We can define the data types. insert or delete fields
and set the Primary Key. in this view.

Datasheet View: It is used to enter and view the data
for the records, to be saved in a table.

Q 22. Write characteristics of a query.
Ans. Characteristics of a query are as follows:

(i) After creating a query, we can run it to view the
selected data from the database. Thus, running
a query is like asking a question on a database.

(ii) At the time of query creation. we can define the
search criteria to find the specific records.

(ili) Access enables us to either deslgn queries on
our own or it also offers the wizard feature
using which we can create a query by following
a sequence of steps.

(iv) Different types of queries can be defined to
view, update, insert or delete data.
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Q 23. What is the use of Macros in a Spreadsheet?

Ans. Macros help In saving time in cases when the
same set of tasks are to be done repeatedly Uke
formatting or applying a similar formula In a similar
range of data. It can be used to name and record a
set of actions.

Q 24. Distinguish between a record and a field in a table,
with an example.

Ans. Distinguish between a record and a field in a table
are as follows:

S.No. FESE' of Record Fleld
Difference

(i) |Definition |Itis a collection of lt is an area
data items, which within the record
represent a complete | reserved for a
unit of information | specific piece of
about a thing or a data.
person. o

(i) [Cancept |Arecordreferstoa |A field refers to
row in the table. a column In the

table.

(iii) | Qther Record Is also known [ Field is also

name as tuple. known as
attribute.

(iv) |Example |eg. if Employeelis [eqg.if Employee
a table. then entire  |is a table.
information then empld.
of an employee Is empName.
called a record. department.

salary are the
flelds.

Q 25. Write the steps to move a field.
Ans. Perform the below mentioned steps to move a field:

G- TiP
Students should go through the steps properly in a
T sequential order.

Step 1: Open the table in the Design view.
Step 2: Select the row that contains the field to be

moved.

Drag the field to the new place. A line
appears between the fields as we drag over
them. It specifies the position where the
field will be placed.

The selected fleld will be placed at the new

Step 3:

Step 4:

positlon after releasing the mouse button.

Q 26. Write the steps to edit the records.
Ans. Perform the below mentioned steps to edit the

records:

Step 1: Clck inside the cell where we need to edit
the data in the Datasheet view.

Step 2: A pencil icon indicating the Edit mode

appears.
Step 3: Enter the new data.

Step 4: Click outside the cell to apply the change.
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Q27.
Ans.

Q 28.
Ans.

Q 29.
Ans.

Q 30.

Ans.

Q 3L
Ans.

Write the steps to sort records in a table.

Perform the below mentioned steps to sort records

In a table:

Step 1: Place the cursor in the field that we wish to
sort. by clicking on any record in the table.

Step 2: Click either the sort Ascending or sort
Descending icon on the Home tab in the
Sort and Filter group, to sort the database
as per the specific field.

Write the steps to delete a row or record.

Perform the below mentioned steps to delete a row

or a record.

Step 1: Select the entire row or a column that
needs to be deleted.

Step 2: Press the Delete key on the keyboard to
delete the unwanted column or row.

Step 3: Access confirms the deletion by displaying
the message.

Step 4: Click on the Yes button to confirm deletion
of the selected record.

Write the steps to delete a record.

Perform the below-mentioned steps to delete a

record:

Step 1: Open the form In the Form view.

Step 2: Select the record or records that we want
to delete. To select a record. click on the
record selector next to the record, if the
record selector Is available.

Step 3: To extend or reduce the selection, drag the

recard selector, or press the Shift + Down

arrow keys ar the Shift + Up arrow keys.

Now press the Delete key or select the

Delete option on the Records group in the

Home tab, or press the Ctrl + minus sign (-).

Step 4:

What is a Primary Key? How is it different from
Foreign Key?

A Primary Key is a column or group of columns in a
table that uniquely Identify every row/record In that
table.

Primary Key Foreign Key

A table can have
more than one
fareign key.

(i) | A table cannot have
more than one
primary key,.

(i) | Primary key can't
accept null values.

Foreign key can
accept multiple null
values.

Explain referential integrity.

Referential integrity is a system of rules that
MS Access uses to make sure that relationships
between records In related tables are valld and
we do not accidentally delete or change related
data. Referentlal integrity relationships help make
sure that the information In one table matches the
information in another.
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Q 32.

Ans.

Q33.

Ans.

Q 34.
Ans.

Q 35.

Ans.

Q 36.
Ans.

Q 37.
Ans.
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Mention the use of referential integrity between
tables.
Referential integrity is used between tables for the
following purposes:

(I) To make sure that the data stays synchronised.

(i) Tomake sure that relationships between records
In related tables are valld and the related data Is
not accidentally deleted or changed.

Differentiate between one-to-many relationship
and many-to-many relationship.
One-to-Many Relationship: A one-to-many relationship
is the most common kind of relationship. In this
kind of relationship. a row in table A can have many
matching rows in table B. However, a row in table B
can have anly one matching row in table A.
Many-to-Many Relationship: In a many-to-many
relationship, a row in table A can have many
matching rows in table B, and vice-versa. We create
such a relationship by defining a third table that
Is called a junction table. The primary key of the
junction table consists of the foreign keys fram both
table A and table B.
What are the main purposes of a database system?
The main purposes of a database system are as
follows:

(i) Storage of information.

(i) Retrieval of information quickly.

(iii) Sorting. selecting data that satisfles certain

criterla (filtering).
(iv) Produce the report in some standardised and
readable format

What is the difference between ‘Rows’ and ‘Columns’
in a table?

In a table, rows are called records and columns are
termed as fields. A row stores complete information
of a record whereas calumn stores only similar data
values for all records.

Define query in the context of database.

A guery is an inquiry into the database using the
SELECT statement. These statements gjve you filtered
data according to your conditions and specifications
indicating the fields, records and summaries which a
user wants to fetch from a database.

Define forms and what is the need of using them?
In a database. a form is a window or a screen that
contains numerous fields or spaces to enter data.
Forms can be used to view and edit your data. It Is
an interface in user specified layout.

e.g.. a user can create a data entry form that looks
exactly Uke a paper form. People generally prefer to
enter data into a well-designed form, rather than a
table.

Q 38.
Ans.

Q 39.

Ans.

Q 40.
Ans.

Q 4l

Ans.

Q 42.

Ans.

Q43.

Ans.

What do you understand by report?

When you want to print those records which are
fetched from your database. design a report. It is an
effective way to present data in a printed format. It
allows you to represent data retrieved from one or
more tables, so that it can be analysed.

How are fields, record and a table related to each
other? Explain with the help of an example.

Flelds are one type of information. A record contains
logically related fields. A table Emp name contains
logically related records.

EmpNo Name Salary
1 Shrdhar 20000
2 Raghav 40000

Here. EmpNo, Name and Salary are three different
fields. 1, Shridhar, 20000 represents one complete
record.

Distinguish between data and information.
Distinguish between data and Information are as
follows:

Data Information

It Is a raw facts. It Is a process form of

data.

It considers knowledge
derived from study,
experience or instruction.

It cansiders facts
symbols, images for
reference or analysis.

e.g. 23 is a data. e.g.age = 23 is

information.

A table named School (containing data of students
of the whole school) is created, where each record
consists of several fields including AdmissionNo

(Admission Number), RolINo (Roll Number), Name.
Which field out of these three should be set as the
primary key and why?

AdmissionNo should be set as primary key because
admission numbers are unique for each and every
students of the school. which is not possible In the
case with RollNo and Name.

What is the difference between Flat file and Relational
file?

The difference between Flat file and Relational file
as follows:

Flat File Relational

Data is stored in
multiple tables.

Data Is stored in a
single table.

It Is suitable for less
amount of data.

It Is suitable for large
amount of data.

Identify the data type in which we can store the
decimal value:

(i) Boolean (ii) Tinyint (i11) Decimal
(iv) Real (v) Double (vi) Smallint
Data types In which we can store the decimal value
are:

(iii) Decimal

(iv) Real (v) Double
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Q 44. Write the data type suitable for the following fields.
(i) Date of Birth
(i) Name
Ans. (i) Date of Birth - Date
(i) Name - Char or Varchar
Q 45. Write four appropriate field names and their data
types to store record of student.
Ans. Four appropriate field names and their data types to
store record of students are:

(P NEME cmmmeuags Char / Varchar
(i) Admno...— . Integer
(ll) Fees Float/Double
(IV) DOB .o Date

Q 46. Write four appropriate field names and their data
types to store record of book.

Ans. Four appropriate field names and their data types to
store record of book are:

(I) AULROr_NaMEe ..o Char / Varchar
(1) Il J—— Float / Decimal / Double
(iii) Class ... Char / Varchar
(V) SUBJEEL s . Char / Varchar

Q 47. Answer the following questions on the basis of
following table:

Table: Student

Stud id Stud_name Class Fees
| Aman IX 3000
2 Anil X 3200
Table: Teacher
T Id T_name T_Sal Stud_Id
3210 Mr. Kumar 60000 : £
3211 Mr. Sethi 70000 2
(i) Identify the primary key in Student and Teacher
table.

(i1) lIdentify the foreign key in Teacher table.
Ans. (I) Primary key In Student table : Stud_ld
Primary key in Teacher table is : T_id
(i) Foreign key in Teacher table is : Stud_id
Q 48. Write the data type suitable for the following fields:
(i) Rollno (1) Class
(iii) Email (iv) City
Ans. (I) Rollno - TinyInt / Smallint / Integer
(ii) Class - Char / Varchar
(iii) Email - Char or Varchar
(iv) Oty - Char or Varchar
Q 49. Consider the following table:

Table: Employee

EmpNo. EmpName Designation
1 Sahil A
2 Anup B
3 Mansi A
4 Pooja B
(i) Which of the above field can be selected as a
primary key?
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(1) EmpName field also has unique values for all
the records. Can it be made primary key? Give
answer with reason.

Ans. (i) EmpNo can be selected as a primary key.

(i) EmpName Is having unique values, but there is no
guarantee that if more employees are included
then there would not be multiple people with
similar names. So, in future its values may be
duplicate. Thus, it cannot be made as a primary
key.

Q 50. Sanchita is working for a nationalised bank and
is in the process of creating a table to store the
details of customers of the bank.

Find out, which of the following fields of table
Bank can be selected as primary key, candidate key
and alternate key?

Account No, Customer Name, Date of Birth, PAN
Number, Opening Balance

Ans. Primary key - AccountNo
Candidate key - AccountNo and PAN Number
Alternate key - PAN Number

Q 5L Identify the columns out of the given three, which
should not be present in each of the following

tables:
(i) Table 1: Stock
ItemNo. DateofBirth Itemquantity
(i1) Table 2: Book
Admno Price AccessNo
(iii) Table 3: Firmotire
F_No DesignCat Phonenumber

Ans. (i) DateofBirth (ii) Admno (jii) Phonenumber

Q 52. Write SOL commands for the following:
Table: Graduate

SNo. | Name | Stipend Subjact Average | Div
1. | Karan 400 | Physics 68 i
2. | Divakar | 450 | Computers 68 1
3. | Divya 300 | Chemistry 62 2
4. | Arun 350 | Physics 63 1
5. | Sabina 500 | Mathematics 70 1
6. |John 400 | Chemistry 55 2
7. | Robert 250 | Physics 64 1
8. | Rubina 450 | Mathematics 68 i)
9. | Vikas 500 Computers 62 1|

10. | Mohan 300 | Mathematics 57 2
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(i) List the name of those students who obtained
DIV 1 sorted by NAME.

(i) Display a report, listing NAME, STIPEND,
SUBJECT and amount of stipend received in a
year assuming that the STIPEND is paid every
month.

Ans. (i) SELECT name FROM graduate WHERE div=1
ORDER BY name;

(i) SELECT name. stipend. subject stipend®12
FROM graduate:

Q 53. Write the output of the following on the basis of

given:
Table: Product
Pid P_name Price Oty
1 pl 240 23
2 p2 300 24
3 p3 320 43
4 p4 130 32
5 p5 100 17

(i) Select max(price) from product;
(ii) Select avg(price) from product;

Ans. (i) 320
(ii) 218
Q 54. Write the output of the following on the basis of
given:
Table: Product

Pid P_name Price Qty

1 pl 240 23

2 p2 300 24

3 p3 320 43

4 p4 130 32

5 p5 100 17

(i) Select min(qty) from product;

(i1) Select count(®) from product;
Ans. (i) 17
(i) 5

'@f Lnng AnSwer Type Questions N\

Q1 What is DBMS? Explain any two advantages of
DBMS.

Ans. A database management system Is a software
package with computer programs that controls
the creation. maintenance. and use of an Integrated
collection of data records, files, and other objects.
It allows organisations to convenlently develop
databases for various applications.

Advantages:

(I) Data Integrity: It means the data Is accurate and
consistent in the database. It is very important
as there are multiple databases In a DBMS so It
helps to produce the correct result
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(ii)) Data Sharing: In a database, the users can
share the data among themselves. Data can
be shared for multiple purposes with the users
located at different geographical locations and
then remote users can also access the database
simultaneously.

Q 2. State the difference between Flat File based
database management systems and Hierarchical
database management systems along with the
help of examples.

Ans. Flat File Based Database Management Systems, also
known as Flat models, are the simplest database
management systems. These store information in
flat files having rows and columns to store data.
Flat files cannot be linked to each other. Thus. data
cannot be viewed from multiple files at the same
time. Spreadsheet software such as MS Excel Is
the most common example of a Flat File Based
Database Management System.

Hierarchical Database Management Systems
function an the parent child tree-like model These
store the data items along with the description of
the data items. such as a boak with information on
chapters and verses. These can also be used to store
a database of songs, recipes, models of phones and
anything that can be stored In a nested farmat
An XML document is an example of a Hierarchical
Database Management System.

Q 3. Explain any four data types of DBMS. [cBSE2023]
Ans. The four data types of DBMS are as follows:

(I) Numeric data types: They are used for
describing numeric values far the field used in
the table of a database. These data types in a
database can be used for storing Information
such as mobile number, roll number, door
number, year of school admission, true ar false
statements, statistical values. etc.

(i) Alphanumeric data types: They refer to a
description of data comprising of both lettersand
numbers. For example. “1a2b3c” Is a short string
of alphanumeric characters. Alphanumeric Is
commonly used to help explain the availability
of text that can be entered or used In a field.
such as an alphanumeric password field.

(iii) Binary data types: They are used for staring
data in binary formats. Binary data types In a
database can be used to store photos. music
files, etc. In general. files of any format can be
stored using the binary data type.

(iv) Data-Time data types: They are used to
describe the data and time values for the field
used in the table of a database. Data-time types
In a database can be used to store Information
such as date of birth, date of admission, date of
product sale, etc.
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Q4.
Ans.

Q5.

Ans,

Q6.

What are the objects? Explain.
The objects are as follows:

Query: A query is a question put up on the database
to view the records. matching the criteria defined
by us. Using a query. we can view or manipulate a
selected set of the data stored in a single table or
multiple related tables.

Form: A form Is a graphical object that acts as an
Interface between a user and the tables, where the

data is stored. With forms, we can view., edit. input
and delete records stored in the tables. Forms allow
us to deal with one record at a time.

Report: A report Is a graphical object that presents
data in a formatted layout. This is useful far

displaying data in an organised manner and for
printing,

Macros and Code: A set of actions created to
automate common tasks is known as a macro. A
code refers to the declarations, statements and
procedures written in the programming language.

Discuss the difference between a Form and a
Report in detail.

Form: A form is a graphical object that acts as an
interface between a user and the tables. where data

Is stored. With forms. we can view. edit. input and

delete records stored In the tables. Forms allow us
to deal with one record at a time.

Characteristics of a Form:

(I) Form provides a quick and convenlent way to
enter. modify and view records in a database.

(i) It also enables a database designer to ensure
that data entered through form is saved into
desired tables, not any where else.

Report: A report is a graphical object that presents

data in a formatted layout. This is useful for

displaying data in an organised manner and for

printing.

Characteristics of a Report:

(I) Access enables us to create a report elther
from a table or query.

(i) Reports can be viewed before final printing.

(iii) If forms are for input purposes. then reports
are for output purposes.

(iv) Reports enable us to present components of
our database in an easy-to-read format

(v) We can even customise a report's appearance
to make it visually appealing.

(a) Structure of a table "Orders” is given below.
Suggest suitable data type of each column.

Table: Orders

Order ID | Order data |Customer ID| Amount

A_101 12/12/19 C3445 1200.00
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A_202 11/059/19 C1245 3456.00

A_402 09/07/19 2121 231200

(b) Consider the following table “Books".
BkID BkName Author Qty | Price

B_101 |Learning with Fun Jacobins 5 | 355.00

B_103 [How I Live Now Meg Rosoff 4 1400.00

B_104 |I Capture the Castle| Dodie Smith 5 | 520.00

B_106 [Mortal Engines Philip Reeve | 4 | 260.00
B 110 |[The Kite Rider Geraldine 3 |270.00
McCaughrean
Write SOL queries to
(i) Display data of all books whose quantity is more
than 3.
(ii) Display total amount of all books whose price is less
than 500.
(Hint : amount = Qty x Price) [CBSE 2023]

Ans. (a) Order_ID — Char data type
Order_date — date data type
Customer_ID — char data type
Amount — decimal data type
(b) (1) Select® from Books where Qty > 3:
(Ii) Select Qty® Price from Books where Price <500:

Q7. Consider the following table: Student

ADM- GEN-
NO NAME |GRADE DOB MARKS |HOUSE DER

1001 | RUPAL 9 |[10/04/2006| 76 |[GREEN| M

1002 | RASHMI| 9 |08/12/2005| 87 RED F

1003 [ ARNAV | 10 |25/05/2004] 81 |GREEN| M

1004 [SUMONA] 9 |23/08/2005| 68 RED F

1005 | ARUN 9 116/07/2005| 72 |GREEN| M

1006 TIA 9 |22/09/2005| 91 BLUE F

1007 |[ROSHAN| 10 [26/08/2005| 89 BLUE M

Write SQL Commands:
(I) To display the details of all students of Green
House.
(ii) To increase marks by 5 whose ADMNO is 1005.
(iii) To display details of all students whose MARKS
are less than 80.
(iv) Display the list of all students in descending order

of MARKS. [CBSE SQP 2022, Term-2]
Ans. (i) Select ° from Student where HOUSE = 'GREEN;

(i) Update Student set MARKS = MARKS + 5 from
Student where ADMNQ = 1005;

(ii) Select ° fram Student where MARKS < 80;

(iv) Select ° from Student order by MARKS desc;
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Q 8. Write the steps to add a record to a form.
Ans. The steps to add a record to a form are:

Step 1: Open the form in the Form view.

Step 2: Click on the New option on the Records
group in the Home tab, or press the Ctrl +
plus sign (+).

Step 3: Find the record with an asterisk in the record
selector, and enter the new infarmation.

Step 4: To move to the next fleld in the same row.
press the Tab key. use the Right or Left
arrow keys, ar click on the cell in the next
fleld!

Step 5: When we view another record or close the
form. M5 Access saves the new record that
we have added. To explicitly save changes to
the current record. press the Shift + Enter
keys.

Q 9. Write the steps to establish a relationship between
two tables.
Ans. Perform the below mentioned steps to establish a
relationshlip between two tables:

Step 1: ClickontheRelationshipsintheRelationships
group on the Database Tools tab. The Show
Table dialog box automatically appears.

Step 2: Double-click the names of the tables that
we want to relate, and then close the Show
Table dlalog box by clicking on the Close
button.

Step 3: Drag the Primary Key field from one table
to a similar field that Is called the Foreign
key in the other table. The Edit Relationships
dialog box appears.

Step 4: Click on the Create button to create
the relationship. A black line appears
between both the fields to denote that the
relationship is established.

Q10. (i) The structure of a table 'ITEM’ is given below.
Suggest suitable data type and size of each

column.
Column name Type Size
2] 12 1 o L U
Iname
Price .eeees SRR .
(ii) Consider the following table ITEM':
Table: Item
Itemno Iname Price | Quantity
11 Soap 40 80
22 Powder 80 30
5. Face cream | 250 25
44 Shampoo 120 100
55 Soap box 20 50

Write queries to:

(a) Display the total amount of each item. The
amount must be calculated as the price
multiplied by quantity for each item.

(b) Display the details of items whose price is
less than 50.

Ans. (I) Itemno Integer (10)
Iname Varchar (15)
Price Decimal (5. 2)

Quantity Integer (3)
(i)(a) Select price ®* Quantity fram item:
(b) Select * from item where price <50:

Q 11. Consider the following table: STUDENT.

REGD.NO NAME BRANCH
0001 Ram ESE
0002 Hari MECH
0003 Pradeep EEE
0004 Deepak ETE
(i) Write a SQL command which will show the
entire STUDENT table.

(i) Write down the SOL command which will show
the REGD. NO of Pradeep.

(iti) Write down the SOL command which will show
the Name and Branch column.

(iv) Write a SOL command which will count the
number of rows existing in STUDENT table.

(v) | want to add another column in the STUDENT
table as"address”. How can | do that?

Ans. () The SQL command which will show all the
information in STUDENT table is:
SELECT *° from STUDENT;
(i) The SQL command which will show the
REGD.NO of Pradeep is:

SELECT REGDNO from STUDENT WHERE
NAME=Pradeep;

(i) The SQL command which will show the NAME
and BRANCH column Is:

SELECT NAME, BRANCH from STUDENT:;

(lv) The SQL command which will count the number
of rows present in STUDENT table Is:
SELECT COUNT(®) from STUDENT:;

(v) To add another column in STUDENT table. we
can use ALTER command as:

ALTER TABLE STUDENT ADD address Varchar2(30):
Q12. (i) Create a table SHOP with the following fields:

Column Name Data Type
Code Varchar(5)
Name Char(50)
Type Varchar(3)
Cost Int

Margin Float
Qty Int
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(if) Consider the following table Employee Salary and write the queries (a) and (b).

Table: EmployeeSalary

LastName FirstName Dept PayrollNumber Salary () JobTitle
Shen James Finance AB2I 19500 Payroll Clerk
Gupta Shruthi Finance M502 35000 Accountant
Bedi Reeta Human Resource M4 21 18500 Secretary
Walker Tia Sales wWa15 24000 Sales Representative
Shafia Ahmed Factory H219 395000 Factory Manager
Mittal Chavi Purchasing M134 20000 Purchasing Clerk

(@) Write a command to update the salary of
the employee to 25000, whose job title is
secretary.

(b) List all data of table EmployeeSalary.

Ans. (i) CREATE TABLE SHOP (Code Varchar(5). Name
Char(50). Type Varchar(3). Cost Int. Margin
Float, Qty Int):
(i) (a) UPDATE EmployeeSalary SET Salary
= 25000 WHERE JobTitle = ‘Secretary"
(b) SELECT ° FROM EmployeeSalary;

Q 13. Discuss the components of a database.

Ans. A database consists of several components. Each
companent plays an important role in the database
system environment.

The major components of database are as follows:

(i) Data: It Is raw numbers. characters or facts
represented by value. Most of the organisations
generate, store and process large amount of data.
The data acts as a bridge between the hardware and
the software. Data may be of different types such as
User data. Metadata and Applcation Metadata.

(ii) Software: It is a set of programs that lies between
the stored data and the users of database. It Is used
to control and manage the overall computerised
database. It uses different types of software such
as MySQL, Oracle, etc.

(ili) Hardware: It is the physical aspect of computer,
telecommunication and database. which consists
of the secondary storage devices such as magnetic
disks. optical discs etc.. on which data Is stored.

(iv) Users: It is the person, who needs information from
the database to carry out its primary buslness
responsibilities.

The various types of users which can access the

database system are as follows:

(a) Database Administrator (DBA): A person, who is
responslble for managing or establishing policies
for the maintenance and handling the overall
database management system Is called DBA

(b) Application Programmers: The people. who

write application programs in programming
languages to interact and manlpulate the
database are called application programmers.
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(c) End-user: A person, who interacts with the
database system to perform different operations
on the database like Inserting, deleting etc.,
through menus or forms.

Q 14. Write the steps to design a database.

Ans. Steps to Design a Database: There are various steps

to deslgn a database which are as follows:

Step 1: Determine the Purpose of your Database: The first
step of designing a database is to determine the
purpose and mechanism to deslgn and use it.

Step 2: Determine the Tables: Tables are one aof the most
important elements of a database, consist of rows
and columns. To create a well-defined database.
you have to keep some conditlons which are as
follows:

e Atable should not contain duplicate information.

e Each table should contain Information about
one subject.

E.g. one table is used to contain the personal

information of the students and the other is used

to contaln the marks scaored by the student

Step 3: Determine the Fields: After creating a table, you
need to decide the type and number of fields required
for the tables in your database. Each field in a table
contalns Individual facts about the table's subject.

e.g., A customer table may include company name.
address, city, state and phone number fields.

Step 4: Identify the Primary Key in a Table: From the flelds
of table. you need to identify a primary key which
uniquely identifies each individual record of the
table. The primary key helps you to reduce data
duplication in the table.

Step 5: Determine the Relationship between Tables: In this
step. you need to determine relationship between
two or more tables In your database. You can
set-up a relationship between tables on the basis
of common field between them. Establishing a
relationship allows you to fetch any Information
from both the tables.

Step 6: Refine the Design: After you have designed the
tables, fields and relationships. its time to study
the deslgn and detect any faults that might remaln.

Step 7: Enter Data and Create other Database Objects:
When you are satisfied that the database structure
meets the goals you needed. add all your existing
data to the tables.
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Q 15. Consider the following database Student:

Student

Roll First Last Eias I‘\‘!urks Scholarship
No. Name Name Obtained (%) | Awarded (%)
1205 | Mohan Garg 12th 99.9 50000
1009 | Dushyant | Singh | 10th 98.7 45000
1101 Swatl Rona | 11th 95.4 30000

945 | Ravindra | Saini 9th 97.5 35000
1015 Ritika Thakur | 10th 98.6 40000

() Find the marks obtained by the student with
Roll No. 1101.

(i) What is the name of the student, who has got
the highest marks and what is the amount of
scholarship awarded to him/her?

(i1i) How many records are there in the table?

(iv) How many fields are there in the table?

Ans. (i) 95.4
(ii) Mohan Garg and scholarship awarded is 50000.
(iii) 5
(iv) 6
Q 16. The director of a company uses a database to store
data about job title. This is a part of the database
given below:

Student
Last First Payroll | Sala
Name Name R Nurnber m"}‘ i
Shen lames Finonce A621 | 19500 | Payroll Clerk
Gupta | Shruthi Finance M502 | 35000 | Accountant
Bedl Reeta Human M421 | 18500 Secretary
Resource
Walker Tia Sales w815 | 24000 Sales
Representative
Shafia | Ahmed Factory H219 | 39000 Factory
Manager
Mittal Chavi | Purchasing | M134 | 20000 Purchasing
Clerk
(i) How many records are there in this part of the
database?
(i) How many fields are there in this part of the
database?
(ili) What is the job title of the employee with Payroll
Number M421?

(iv) Which department has maximum employees and
what are their Payroll Numbers?

() 6
(i) 6
(iii) Secretary
(lv) FiInance department and their Payroll Numbers
are Ab21 and M50
Q 17. (i) Create a table customer with following details:

Ans.

Column Name Data Type

CustNo Varchar(5)
Name Char(20)
Address Char(50)

(ii) Consider the following table MASTER and
write the queries (i) and (ii).

Table: Summer Camp

E'I‘gd First Name r}:;te DOB | Gender| Group
109 | Vedansh |Gupta |[30/06/10 M 2A
214 Mack | Tyagl 09/12/08 M 1B
115 Aditi | Thakur |13/04/09 F 1A
108 Vikrant |Chauhan|02/02/09 M 2A
141 Swati | Sainl 06/05/10 F 2B
233 | Vishakha |Tyagi 01/08/10 F JA
274 | Madhur [Gupta |06/03/10 M 3B

(a) Write a command to insert a new record with
the following values:
(105, 'Shyam’, 'Sharma, 07/09/10, ‘M, "1A)

(b) Write a query to display all the records of
table SummerCamp whose DOB lies between
02/02/09 and 06/03/10.

Ans. (I) Create Table customer (CustNo Varchar(5), Name
Char(20). Address Char(50)):
(i) () insert into SummerCamp VALUES (105,
'Shyam’, 'Sharma’, 07/09/10, ‘M’ 1A);
(b) SELECT °FROM SummerCamp where daob
between 02/02/09 and 06/03/10:

@ Chapter Test

Multiple Choice Questions

Q 1. Cascade delete option:

a. Is used to delete all the records of all tables in a
database

b. will repeat the recent delete operation to all the
records of current table

C. is available in Edit relationship dialog box which
makes sure that all the related records will be
deleted automatically when the record from
parent table is deleted

d. None of the above

Q 2. This data type allows alphanumeric characters and
special symbols.
a. Text b. Memo
c. Auto number d. None of these

Q 3. Query design window has two parts. The upper part
shows:
a. name of fields. field type and size
b. tables with fields and relationships between tables
C. criterla
d. sarting check boxes

Q4. In a database table, the category of information is
called:
a. tuple b. field

C. record d. All of these
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Q5.

Q6.

To create a new table, in which method you don't
need to specify the field type and size?

a. Create Table in Design View

b. Create Table using Wizard

c. Create Table by Entering Data

d. All of the above

Which of the following is not a database object?

a. Tables b. Queries

c. Relationships d. Reports

Fill in the Blanks Type Questions

0 1 S database models comprise of varied
structures.

Q6. A.......oo e eeeevnenee. IS @ COLlection of different objects.

B ccacuns is a relational database management
system.

Assertion and Reason Type Questions

Q10

Q 1L

Ql2.

Case

Directions (Q. Nos. 10-12): /In the questions given

below, there are two statements marked as Assertion

(A) and Reason (R). Read the statements and choose the

correct option.

a. Both Assertion (A) and Reason (R) are true and
Reason (R) Is the correct explanation of Assertion (A).

b. Both Assertion (A) and Reason (R) are true., but
Reason (R) Is not the correct explanation of Assertion
(A).

c. Assertion (A) Is true, but Reason (R) Is false.

d. Assertion (A) Is false. but Reason (R) Is true.

. Assertion (A): Forms can be used for inputting
data.

Reason (R): Reports are used to output data.

Assertion (A): Reports can be viewed before final
printing.

Reason (R): Records cannot be edited in a table.
Assertion (A): Reports are used to format,

summarise and compile data in a presentable
manner.

Reason (R): Reports do not allow printing the data
of a database.

Study Based Questions

Q13.
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A School in Delhi uses database management
system to store student details. The school
maintains a database ‘school_record’ under which
there are two tables.

Student Table: Maintains general details about
every student enrolled in school.

StuLibrary Table: To store details of issues
books. BookID 1s the unique identification
number issued to each book. Minimum issue

duration of a book 1s one Day.

Student Stulibrary
Field Type Field Type
StulD numeric BookID | numeric
StuName | varchar(20) StulD numeric

StuAddress| varchar(50) | |lssued_date| Date

StuFather- | varchar (20) Return_ Date
Name date

StuContact numeric

StuAadhar numerlc

StuClass | varchar (5)

StuSection | varchar (1)

(i) Identify the SQOL Query which display the data
of Stulibrary table in ascending order
of Student-ID.

(1) Select ® from StuLibrary Order By BookID
(Il) Select * from StuLibrary Order By StulD
(111) Select ® from StuLibrary Order By StulD ASC
(IV) Select ° from StuLibrary Order By StulD DESC
Choose the correct option:
a. Query (1) and (IV) will display the desired data.
b. Query (1) and (Il) will display the deslired data.
c. Query (Il) and (IV) will display the desired
data.
d. Query (Il) and (IIl) will display the desired data.
(ii) The primary key for StuLibrary Table is/are..........
a. BookID b. BookID. StulD
c. BooklD. Issued_date d.Issued data
(iii) Which of the following SQL Query will fetch
ID of those issued books which have not been
returned?
3. SELECT BookID from Stulibrary where BookID
Is NULL,;
b. SELECT BookID from Stulibrary where StulD Is
NULL;
c. SELECT BookID from Stullbrary where Issued_
date is NULL;
d. SELECT BookiD from Stulibrary where

Return_date is NULL;
(iv) The alternate key for Student Table will be

‘2. StuName b, StuContact
c. StuAadhar d. StuClass

Very Short Answer Type Questions

Q 14. What is a report?

Q 15. What do you mean by datasheet view?

Q 16. What do you mean by design view?

Q 17. Write steps to open table in design view.
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Short Answer Type Questions

Q 18. Write the output of the following on the basis of

given:
Table: Product
Pid P_name Price Oty
1 pl 240 23
2 p2 300 24
3 p3 320 43
e p4 130 32
5 p5 100 17

(i) Select count(Qty) from product;
(ii) Select distinct(price) from product;
Q19. Write the output of the following on the basis of

given: Table: Product
Pid P_name Price Qty
| pl 240 23
2 p2 300 24
3 p3 320 43
4 p4 130 32
5 p5 100 17

(i) Select count(distinct(price)) from product;
(ii) Select price * Qty from product;
Long Answer Type Questions

Q 20. (i) Create a table Student with following fields:

Column Name Data Type
Reg_No Char(15)
Reg Date Date
Owner_Name Varchar(20)
Address Varchar(40)

(i) Consider the following table MASTER and write
the queries (a) and (b).

Table: MASTER

S.No.| Name Age |Department | Group

1 Shyam 21  |Computer 12000

2 Shiv 25 Maths 15000
3 Rakesh 31 Hindi 14000
4, Sharmila 32 Histary 20000

5. | Dushyant 25 | Software 30000

(a) Write a command to update the Salary of the
employee to 40000, whose S.No. is 3.

(b) Write a query to add a column Date of_
Joining to the table MASTER.

Q 21. Consider the following database Student:

Students
| | | | vt | S
1205 Mohan Garg 12th 99.9 50000
1009 | Dushyant Singh 10th 98.7 45000
1101 Swati Rana 11th 95.4 30000
945 Ravindra Saini 9th 97.5 35000
1015 Rrtika Thakur 10th 98.6 40000

(

(i) Find the marks obtained by the student with
Roll No.1101 ?

(ii) What is the name of the student, who has got
the highest marks and what is the amount of
scholarship awarded to him/her?

1ii) How many records are there in the table?

(iv) How many fields are there in the table?
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